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Specimen Radiography System

Forward

This manual was created by Faxitron Bioptics LLC, a Hologic® Inc. Company. It is intended to guide the user on how to setup,
install and use the Faxitron Path hardware and the Vision Software System, both developed by Faxitron Bioptics LLC.

Faxitron Path was previously known as PathVision

The user must first setup the hardware, then initiate the Vision Software. Please review the required setup procedures in Part 2
of this manual before continuing.

Indications for Use

The Faxitron Path is a Cabinet x-ray system that is used to provide film and/or digital x-ray images of harvested specimens
from various anatomical regions in order to provide rapid verification that the correct tissue has been excised during the biopsy
procedure. Doing the verification directly in the same room or nearby enables cases to be completed faster, thus limiting the
time the patient needs to be under examination. Specimen radiography can potentially limit the number of patient recalls.
v'Prescription use (Part 21 CFR 801 Subpart D)

Caution: Federal law restricts this device to sale by or on the order of a physician.

The system can operate as a standalone device. If connected to a network, it is critical that measures are implemented to

reduce the risk to patients by decreasing the likelihood that device functionality is intentionally or unintentionally compromised
by inadequate cybersecurity.
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Faxitron Path

Specimen Radiography System

This manual was created by Faxitron Bioptics LLC, a Hologic Company. It is intended to
guide the advanced user on how to setup, install and use the Faxitron Path hardware and
Vision Software, both developed by Faxitron Bioptics LLC.

Read all this information carefully before operating the system. Follow all warnings and
precautions as stated in this manual. Keep this manual available during procedures. Always
follow all the instructions in this manual. Faxitron Bioptics, LLC does not accept
responsibility for injury or damage from incorrect system operation. Faxitron Bioptics, LLC
can arrange for training at your site.

Thank you from all of us at Hologic.

Additional Information

For further technical assistance contact:

o

EC |REP

3440 E. Britannia Dr. Suite# 150 Hologic BVBA
Tucson, AZ 85706 Da Vincilaan 5

+1 (877) 910-0030 1930 Zaventem
(520) 514-8182 Fax Belgium
www.faxitron.com Tel: +32 2 711 46 80

Fax: +32 2 725 20 87 c €

The following symbols are used in this manual and online help system:

P> P

Warns the reader of potential electrocution should the reader ignore the warning
and deliberately use specialized tools to open a sealed electrical cabinet and
handle its contents. Note: No tools are provided by Faxitron Bioptics LLC.

Warns the reader of a hazardous condition. This symbol is generally
accompanied by a more specific symbol and appropriate instructions as to the
nature of the hazard, the expected outcome of the hazard, and information on
avoiding the hazard.

Cautions the reader to use care in lifting heavy equipment in order to avoid
personal injury and damage to the equipment.

Warns the reader that ionized radiation is emitted into the labelled area when
the x-ray beam is energized. The Faxitron Path has safety interlocks to prevent
the labelled area from being accessed while the x-ray beam is energized.

Warns the reader to use appropriate protection (such as surgical gloves or an
approved specimen container) to avoid exposure to potentially infections
materials such as patient tissue samples.

1.0.0
Introduction

1.1.0

Warning and
Caution Symbols
in this Manual
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Symbol

Description

"ON" for part of the equipment

Potential Equalization terminal

®
1%
E

Discard electrical and electronic equipment
separately from standard waste. Send
decommissioned material to Hologic or contact
your service representative.

Manufacturer

Date of Manufacture

Caution—Radiation (X-Rays Produced)

Caution - Potentially infectious materials

Warning Electricity

Caution

Follow or consult instructions for use

This system transmits radio frequency (RF) energy
(non-ionizing radiation)

Catalog number

Serial number

1.1.1

Warning and
Caution Symbols
On Labels
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SECTION 2
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SECTION

Faxitron Path

Installation
Specimen Radiography System and Setup
Warnings 2.1.0
e Please read the instructions carefully before using the system. System
Warnings &

e Do not use the system in any other way than its intended use as described in this manual.

If in doubt contact Faxitron/Hologic or your authorized distributor. Precautions

e Not all power cords have the same rating. Do not use any other power cord with this
system other than the one provided. Do not use the power cord from this system on any
other equipment.

e This system is tested to the highest international standards; however, it is recommended
that you contact your national authorities regarding any local operational requirements.

e This system is not intended for public use. It must be located in an area where the general
public cannot access the system without an operator being present.

General Precautions
The following precautions must be taken to prevent damage to your Path System:

e Never connect or disconnect communication and/or power cables, while the camera
system power is on. Damage to the CMOS detector or the camera electronics may occur
if the cables are connected / disconnected while the power is on.

e The camera system is fragile, and care should be taken in order to prevent camera
damage. The camera system must never be mishandled, hit, knocked or dropped.

e The Path System has a calibration mode. Calibration must be completed daily to ensure
proper system function. Please refer to the Calibration Procedure.

e Caution — Use of controls or adjustments to perform procedures other than those specified
herein may result in hazardous radiation exposure.

Interoperable Connections

The Path is capable of operating as a standalone device without any input or output to
other devices. Images can be captured, stored and reviewed directly on the system.

However, the system does come with several interfaces. The primary one is the network
connection which allows the system to be connected to a Picture Archiving and
Communication System (PACS). Images can then be transmitted from the device directly
to the facilities network via our software in a DICOM format. See Section 6 for details on
DICOM version. Only Faxitron employees or trained IT personnel at the user facility should
set up this communication.

The system's connections and their intended use are listed below. No other type of
devices should be connected to the Path without approval from Faxitron.

Connection Purpose Device Type Intended User
Ethernet port | To store radiographic images to PACS or Network Set up by Faxitron or facility IT
at rear networked data storage storage personnel.

Used by clinicians.

Ethernet port
at rear

To allow remote connection by the
Faxitron service team, so Faxitron can
diagnose and repair the system.

Network internet
connection

Faxitron or facility IT personnel

USB port at To transfer images from device. This USB storage device | Clinicians or IT personnel with
the front should only be used if PACS or network (Flash Drive) approved access to the system.
is not available.
USB port at To service and maintain the system files | USB storage device | Faxitron or facility IT personnel
the front may need to be copied to and from the (Flash Drive)
computer. For example, software
updates or log files.
USB port at To allow connection of a printer. Vision DICOM or windows Clinicians or facility IT personnel
the rear software allows for connection of a printer

DICOM printer or a standard windows
compatible printer.
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SECTION

Faxitron” Path Installation

Specimen Radiography System and Setup

Cybersecurity

Device security is a shared responsibility between Faxitron and the health care facilities.
Failure to maintain cybersecurity can result in compromised device functionality, loss of data
(medical or personal) availability or integrity, or exposure of other connected devices or
networks to security threats. Faxitron maintains a set of cybersecurity controls to assure the
cybersecurity of its units and to maintain their functionality and safety.

All our units use standard Windows operating system. At installation, we recommend the
facility install all the necessary security measures as defined by their own internal
requirements, as they would with any other PC connected to the network.

The facility can set up the Windows operating system with all the network protocols and
permissions necessary. For example, they can add:

*  User ID and passwords,

» Layered authorization with appropriate authentication,

. Restrictions on software installations,

«  Trusted content requirements, including code signature verification,
*  Set up windows updates including security releases.

In addition, our imaging software (Vision) can be password protected so certain users can
get on to the operating system without being able to open the Vision software.

The unit comes with a physical key that powers on the X-Ray system. This allows the system
to be locked out so even if the software is accessed no x-rays can be initiated.

This unit is designed to be used either as a standalone unit or connected to the Facility’s
internal PACS or other closed-loop network. Itis notintended to be connected to the Internet,
unless (a) the Facility is specifically instructed to do so by Faxitron, or (b) the Facility takes
adequate precautions to ensure the cybersecurity of the unit from threats related to its
Internet connection.

Faxitron will develop updates or patches for the Faxitron software to continue to assure the
product’s safety, as needed throughout the lifecycle of the unit.

Additional security measures, including encryption, can be implemented and Faxitron can
work with the facilities IT department to reduce the risk to patients as a result of cybersecurity
breach.

Cleaning
Internal Chamber

Samples containing biological specimens can harbour infectious agents that are hazardous
to your health. Follow appropriate biosafety procedures: wear gloves when handling tissue
specimens or any material which they come in contact with.

Periodically wipe down the interior of the cabinet with 70-90% isopropyl alcohol or diluted
sodium hypochlorite (5.25%-6.15% household bleach diluted 1:500 provides the proper
concentration). Ensure the specimen area, marked on the chamber floor, is thoroughly
cleaned.

External Chamber

Periodically wipe down the exterior surfaces with isopropyl alcohol, sodium hypochlorite, or
mild soap and water. (See above for appropriate concentrations.) Do not drench or flood
surfaces and do not use abrasives which may scratch surfaces. Do not allow any moisture
to contact any of the systems electrical components. Test cleaning agents on a small
inconspicuous area of the plastic and metal covers to verify they will not damage the finish.

2.1.0 Cont.

A
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SECTION

Faxitron Path Installation

Specimen Radiography System and Setup

The Faxitron Path should be set up by a Hologic authorized representative. Contact Hologic
at telephone number +1-520-399-8180 to confirm that the system has arrived and to arrange
a time for system installation and setup.

Inspecting the Crates

The Faxitron Path System arrives in one large wood crate and one box. Have the shipping
agent transport the crate and box to an area where they can be kept safe from theft, damage,
or environmental extremes until the Hologic authorized representative can install the system.

Check crate and box for any damage. If either appears to be damaged, contact Hologic at
+1-520-399-8180.

The crate is about four feet tall. This crate contains the specimen unit, computer and system
manuals. The box contains the system monitor.

Lifting and Transporting the Crate

Caution: The crate weighs approximately 550 pounds (250 kg). The packaged system should
be kept upright as indicated on the shipping crate.

Unpacking and Assembling the System

The Faxitron Path system can be unpacked and assembled on site by a Hologic authorized
representative. Please contact Hologic at +1-520-399-8180 when your system arrives to
arrange for system setup.

Location

The Faxitrion Path system has ventilation and the power entry connector at the rear of the
cabinet. Leave at least 6” (15cm) of clear space behind the unit when installed to allow
adequate air flow and give the user access to disconnect the power cord.

2.2.0
Faxitron Path
System Setup
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Faxitron Path

SECTION

Installation
Specimen Radiography System and Setup
Environmental Conditions 2.3.0

Operational:
Temperature: 15.5 to 30 degrees C or 60 to 86 degrees F.
Relative humidity: <75 %.

Storage and transport:
Temperature: 0 to 45 degrees C or 32 to 113 degrees F.
Relative humidity: < 75 %.

This equipment is designed for the following conditions:

e Indoor use

e Altitude up to 2000 meters
e Pollution Degree 2

e Over-voltage Category I

Specifications

The Faxitron Path should not be moved once installed. The system was designed as a

stationary unit to be set up on a counter or tabletop.

RADIATION SAFETY

¢ Radiation shielded cabinet.
e Compartment door equipped with dual safety interlocks.

e Radiation: Less than 0.1 mR/hr at 5 cm (2 in.) from exterior surface at maximum kV.

o Certified to comply with standards set by the US Food and Drug Administration, Center

for Devices and Radiological Health, (21 CFR 1020.40).

e Designed to comply with standards set forth by Underwriters Laboratory the US and

Canada

e Faxitron recommends that users receive training in basic ionizing radiation safety before

using the system.

EXPOSURE CONTROL: Automatic or Manual.

X-RAY DUTY CYCLE: 50%

LASER INFORMATION: Class 1 Laser Product
IEC 60825-1 Ed. 2

Complies with 21 CFR 1040.10 and 1040.11 except for
deviations pursuant to Laser Notice No. 50, dated June 24,

2007.

POWER REQUIREMENTS: 100 — 250 VAC, 50/60 Hz, 200 VA Max

HEAT OUTPUT: 500 BTU/hr Max
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Faxitron Path

Specimen Radiography System

SECTION
Installation
and Setup

EXTERIOR DIMENSIONS (Approximate)

2.3.0 Cont.

cm inches
Height 90 36
Width 59 23
Depth 54 21

COMPARTMENT INTERIOR DIMENSIONS (Approximate)

cm inches
Height 57 22.3
Width 39 155
Depth 42 16.5

WEIGHT (Approximate)

With Computer, monitor, keyboard and accessories

kg Ibs
Net 210 465
Shipping 258 570
Cabinet Only
Net 188 415
Shipping 236 520
23" 21"
59cm 54cm
s [l 3
’A_ftf 00RO
L |
|
E (
® o
> —_—
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SECTION

Faxitron Path Camera

Specimen Radiography System Calibration

Calibration 3.1.0

Upon initial start-up of the system or at any time desired by the user, a system calibratonmay ~ Calibration
be performed. Upon initial start-up and after an elapsed time of twelve (12) hours, the following
calibrations must be performed.

To optimize image quality, Vision Software and the hardware requires periodic calibration. This
calibration requires the acquisition of reference images. These images can be grouped into
three (3) categories: Offset images, Dark images and Flat-field images.

The Vision software will either open directly to the Home Menu (Figure 3.1.1) or the
Calibration page (Figure 3.1.2) depending on the elapsed time since the last
calibration. The user can navigate to the Calibration page in order to manually start a
calibration.

Caution: Verify the chamber is empty prior to starting calibration.

To manually start Calibration, click on the “Calibrate” button in the Home Menu.

Figure 3.1.1
Calibrate System Button
Start Procedure
— |
> @ ©,
Calibrate Review Help Shut Down
The user will then be prompted to start the calibration.
Figure 3.1.2
Start Calibration prompt
4|
Skip Start Calibration
Last Calibrated: 200 14:41:53 Tue
ENSURE THE CHAMBER IS EMPTY BEFORE CALIBRATION
Calibration before beginning any procedure is recommended
Once pressed, the calibration process is performed, and the calibration message box is
displayed. During calibration the message box will toggle between “SYSTEM IN
CALIBRATION” and “X-RAY ON”. See Figure 3.1.3.
Figure 3.1.3
I

Calibrating

“-.‘ SYSTEM IN CALIBRATION

The software will automatically go to the Home Menu page when calibration is complete.

Refer to Sections 5.2.0 and 5.2.1 for additional information on calibration.
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Faxitron® Path SECTION 4

Specimen Radiography System Quick Start

SECTION 4
Quick Start

Basic Operation of the
Faxitron Path

HOLOGIC
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Faxitron Path SECTION

Specimen Radiography System QUiCk Start
Before powering up the system, please make sure that all cords and cables are securely 4.1.0
plugged into the system, computer, and monitor. QUiCk Start

Refer to Section 2, Installation and Set-up, of this manual, and the Quick Set-Up and Quick
Start Guides provided with your Path system.

Figure 4.1.1
Path front panel

System Start-up Sequence Protocol

This start-up sequence must be followed to ensure proper system function and image quality.

Power Up System

e Set the power switch on the back of the Path cabinet to the “ON” position.

e Turn the key on the front of the Path cabinet to “ON” (clockwise to the three o’clock
position).
e  Turn the computer and monitor “ON”.

Start Software
Figure 4.1.2

e Verify there is nothing in the Path x-ray chamber. Vision Desktop icon

e The Vision software should automatically start when the Windows
operating system has completed booting. If the software doesn’t
automatically start “Double Click” the Vision Icon on the Windows
desktop.

Calibrate

e Upon initial start-up of the day the software should open to the Calibration page.
e Press the “Calibrate” button and allow the system to complete the calibration.

Additional Recommendations for Consistent image Quality.

Allow the system to perform a complete calibration daily prior to initial system use. The system
is configured to perform this calibration when you start the Vision software.

Perform a complete system calibration after moving the system to another room to avoid
potential imaging difficulties associated with room-to-room ambient temperature and humidity
differences.

HOLOGIC
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Faxitron Path SECTION

Specimen Radiography System QUiCk Start
Basic Imaging Procedures 4.2.0
Image

Warning: Use of the Path in a manner other than that described in this manual may result in

impaired operation of the equipment or personal injury. Acq uisition

Warning: Use approved containers or gloves in order to avoid contact with potentially

hazardous patient tissue samples. 52

Start Procedure

e From the Home Menu page select the Start Procedure button.

Figure 4.1.3
Faxitron Vision program Home
Menu (Main Screen)

Start Procedure

> @
Calibrate Review Help
14:41:53 Tue

e The user will be given options to Select form Work List, Manual Entry, Select from
Database, or Continue with current patient.

O

Shut Down

e To manually enter a new Procedure, select the Manual Entry button.

Figure 4.1.4
< Start Procedure Options

EF‘.I:lt‘muE with current patient el B SRRl E

o The “Patient Information Editor” dialog box will open.
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Faxitron Path

Specimen Radiography System

SECTION
Quick Start

Patient Name: t N Jane

Patient ID: . JD12
Accession #: t N 123456789

Date of Birth: 1920/03/16

Sex:

Procedure Name:

Laterality:

*

=
A4 o

Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

Accept

< Start a New Patient or Procedure

Note: Required Fields are indicated by a white asterisk (*).

Default required fields are: Patient Name, Patient ID, Accession
Number, and Laterality.

e Enter all required fields. The Accept button will not be active if any required field is
missing. The user may complete other fields as desired.

Note: Date of Birth must be entered as yyyy/mm/dd (e.g. 1962/08/13).
e Select Accept to enable image acquisition.
X-Ray Imaging

e Place specimen(s) in a specimen container provided by Faxitron Bioptics LLC, or your
institution, and lay it inside the Path x-ray chamber. The imaging area is designated by an
outline decal. (The user may also place the specimen and container on the magnification
tray provided with the Path system.

e Press the green Start X-ray button (either in the software or on the front of the x-ray cabinet)
to initiate image acquisition/x-rays.

o Wait until image is displayed.
Note: With the Full Auto mode selected, two X-Rays will be taken, the first to work out the

best settings and the second to take the image. The settings used during exposure (kV and
time) will be displayed in the cabinets’ LCD screen.

The Vision software is configured to automatically save the image to the Faxitron database
on the system computers’ local drive. The user can also save the image to the facilities server
by clicking on the PACS icon. See Figure 4.1.6

4.2.0 Cont.

Figure 4.1.5
Patient Data screen

HOLOGIC

FAXITRON PATH USER MANUAL | HOLOGIC | REVISION 022

4-4



Faxitron Path SECTION

Specimen Radiography System QUiCk Start

4.2.0 Cont.

faxitron

Figure 4.1.6
Image Screen

For more information on adjusting the image settings, X-ray controls, and reviewing and save
options, see Section 5.
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SECTION 5
VISION Software
Operation
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Faxitron Path

Specimen Radiography System

SECTION
VISION
Software

Vision Software is a complete image acquisition and processing package, designed exclusively
to work with Faxitron Bioptics X-Ray Generators (such as VersaVision, Faxitron Path,
CoreVision and BioVision Systems.) In addition to the acquisition and processing functions, the
software offers an extensive database module that allows user control and maintenance of
image archiving, storage, filing and retrieval. The software is also Digital Imaging and
Communications in Medicine (DICOM) compliant, allowing saving and printing of Patient
images in DICOM format 3.0. The software has been pre-installed on the computer that was
packaged with your x-ray system.

System calibration is required at the beginning of every new day of system use for best image
quality. The system user may also perform calibration at any time to ensure optimum image
quality.

After calibration, the Home Menu will be displayed, which allows navigation to all other areas of
the software. For ease of use, application buttons are provided, see Figure 5.0.1. These buttons
are in the center of the screen. Button descriptions and definitions are outlined in the following
sections of this manual.

Start Procedure

>

Review Shut Down

Calibrate

2007/07/31 14:41:53 Tue

Sequence Protocol

The start-up sequence must be followed to ensure proper system functionality and image
quality.

Apply power to the Faxitron Path cabinet using the switch on the back of the cabinet. (The mains
power switch is next to the power cord receptacle). Depress “I” for “Power ON” and “0” for
“Power OFF”.

Turn the Faxitron Path cabinet “ON” by inserting the Faxitron Path Key into the key lock switch,
located on the front panel, and turning it clockwise to the 3 o’clock position. Note: the key cannot
be removed in this position.

Turn on the computer and monitor.

The Vision software will automatically start when Windows has completed
its’ boot sequence. A Dialog box will appear to indicate the software has
initialized and is loaded. NOTE: Double click the left mouse button on the
Vision Software icon (located on the Windows desktop) if Vision does not
automatically start. See Figure 5.1.1.

Vision software will open to the Home Menu or the Calibration page
depending on elapsed time since the last system Calibration.

Refer to Section 3, “Camera Calibration”, and Section 5.2.1, “Camera Calibration Overview” for
calibration protocols.

5.0.0

Overview of
Faxitron Vision
Software

Figure 5.0.1
Faxitron Vision Software
Home Menu (Start-up Screen)

5.1.0
Software Start-up

A\

Figure 5.1.1
Vision Software Desktop Icon
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SECTION

Faxitron Path VISION

Specimen Radiography System Software

Calibration Introduction

To optimize image quality, Vision Software and the hardware requires periodic calibration. This
calibration requires the acquisition of reference images.

Upon initial start-up of the system or at any time desired by the user, a system calibration may
be requested and performed. Itis recommended that after an elapsed time of twelve (12) hours,
the following calibrations be performed.

These reference calibration images are used to calibrate a "raw" X-Ray image on a pixel-by-
pixel basis to generate a "corrected" image for display. Image corrections performed include
gain, offset and linearity corrections.

Calibration Sequence

For convenience, Vision software combines the numerous steps of calibration into a single
unified step.

When a Faxitron X-Ray System has been turned off for longer than twelve (12) hours, the
system will automatically request to re-calibrate. It is highly recommended that the system be
re-calibrated after extended periods of inactivity or after the system is moved from one room to
another room with potentially different ambient temperature/humidity settings.

To calibrate the system at any time, click the Calibrate button on the
Vision Home Menu (Start-up Screen) and then press Start Calibration.

See Figures 5.2.1 & 5.2.2. The Dialog will display a status message
during calibration. See Figure 5.2.3.

Calibrate

2007/07/31 14:41:53 Tue

Start Calibration

Last Calibrated: 201 1 14:41:53 Tue

Skip

ENSURE THE CHAMBER IS EMPTY BEFORE CALIBRATION

Calibration before beginning any procedure is recommended

Calibrating

‘5‘ SYSTEM IN CALIBRATION

During calibration, X-Rays may be generated. During X-Ray generation, a Stop X-Ray button
will be made visible to allow a user the option to stop X-Ray through software.

5.2.0
Camera Calibration
Overview

Figure 5.2.1
Home Menu Calibrate button

Figure 5.2.2
Start Calibrate button

Figure 5.2.3
Calibration Status
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Occasionally it may be desirable to incorporate the X-Ray attenuation characteristics of a 5 2 1
uniform attenuator in the flat-field reference calibration images. For example, if all objects to be Advanced
imaged are placed on a thin plastic plate, X-Ray attenuation characteristics of the plate will be ] -
observed in every image acquired. In this case, placing the plate in the X-Ray beam during flat- Calibration
field reference calibration image acquisition could improve image quality. The following is a

summary of the advanced calibration protocol for "Both" (Flat Field and Image):

Place the uniform attenuator on the detector. The entire detector surface should be covered by
the attenuator. For ideal results, the attenuator should be larger than the detector's imaging
area.

From the start-up screen of the imaging software, press the top-right ”* icon to bring the menu
into focus. Select the drop down menu item "Tools" in the horizontal menu located at the top of
the screen, and then proceed to “Advanced Tools” then to “X-Ray Calibration/Exposure Setup’.

o Figure 5.2.4

XRay Generator and Exposure
~GENERATOR SETTINGS — ~ EXPOSURE SETTINGS Dialog Box

K Current SET SetFor  ()Xeray Cal FlatField] (O Manuallmage () Both

Test Exposure Uszer TimesaDU Tanget

md Current 1000
Time[e] | 20 ‘Select O Time @ 40U ‘

; 250 .
Ky eray Cal ADLss |1532E Tz ] |4_?5 | ADU |snua.n |
rn\-:ar;: i Acquire E stimate/Calculate

AUTOMATIC EXPOSURE CONTROL (DM THE FLY)

Magrification -1 .00
 AEC Mode for Image OM [TARGET=Image ADLU)

- NUMEER DF CAL IMAGES | AEC Mode for Flat-Field DN [TARGET =Flat-Field 40U
#-ray Cal [Flat-Field) Averages EI

X-ray Generator and Expozure Settings

B el Eereached BB e e Ear st

-~ IMAGING MODE
E:‘-‘qppl_l,l Manual Imaging Settings On Exit, Disengage Preshat

[ Accept Settings ] [ Cancel ]

NOTE: The kV, Exposure Time, and ADU/s values may vary from those shown.
« Under "X-Ray Generator and Exposure Settings”, enter the generator kV setting in the
appropriate field.
- Set a "Magnification" or leave as the default setting of one (1.0).
« Select the "Set for" "Both" button in the dialog box.

- Leave the default "user ADU target" setting. X-Ray exposure will be terminated when the
detector has accumulated a mean signal level of ADUs that are acceptable for the X-Ray
generator you have.

- Leave the default test exposure time and click on the Acquire button. The system will
automatically begin X-Rays and obtain an image.

» When the X-Ray exposure is complete, click on the Estimate/Calculate button.

 Record the calculated exposure time "Time [s]" reading. The system calculates this time and
the number is greyed out.

- Enter the calculated exposure time reading “Time [s]” in the “Test Exposure” time box. Press
the Acquire button to automatically begin X-Rays and obtain an image.
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» When X-Ray exposure is complete, click on the Estimate/Calculate button.

« Record the calculated exposure time "Time [s]" reading.

- Enter the calculated exposure time reading in the "Test Exposure" time box once again.
» Click on the Accept Settings button.

- Perform a standard calibration procedure, as described in the "Camera Calibration Overview"
section.

Experienced users may wish to set the "X-Ray Cal (Flat-Field)" and "Manual Image" "Exposure
Settings" independently or "Both" (Flat-Field and Manual Image) as previously described. By
selecting the "Flat Field" radio button, the system will determine the optimum exposure time for
acquiring Flat Field images at the desired ADU level. Accordingly, the selection of "Manual
Image" will determine the optimum exposure time for the system with an object which will
attenuate the X-Ray signal. For best results, the entire imaging area of the detector must be
covered by the object.

After the selection of either "X-Ray Cal (Flat-Field)" and "Manual Image" and the ADU level has
been set, select the Acquire button. For the "Manual Image" selection, it is desired to have the
object or X-Ray attenuator in the X-Ray beam. Press the Acquire button to generate X-Rays and
obtain an image. When X-Ray exposure is complete, click on the Estimate/Calculate button.
The system calculates optimum time and the number is greyed out. Click the Accept Setting
button to save the "Exposure Settings" to the system's configuration file. Note: Only the
settings for the selected radio button are saved. Next perform a standard calibration
procedure, as described in the "Camera Calibration Overview" section.

The Start Procedure button,(see Figure 5.0.1), takes the user to the Patient Data Entry page
which provides methods to enter patient data. If a Work List has not been configured, the option
will be greyed out and only the Continue with current patient, Manual Entry, and Select
from Database options will be accessible. The options are explained in the next sections.

Select from Work List

>

Continue with Current Patient

JANE DOE

Select from Database E

5.2.1 Cont.

5.3.0
Patient Data

Figure 5.3.1
Patient Data Entry screen
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SELECT FROM WORK LIST (Remote Modality Work List

If a Work List has been configured the user can click the Select from Work List button which
will display the following page. See Figure 5.3.2 below.

Search Parameters:

Patent Name

Patient 10

sirtn Date

Proc. Start Date 2019/03/28

NOTE: All patient data is fictitious.
_ Any resemblance to actual persons is
1) Query strictly coincidence.

On the left are various filters that may be used to search for scheduled procedures for the
Station Application (AE). Verify that the station AE Title is defined, then any single field or any
combination of fields may be used as a filter to search for scheduled procedures for this AE. By
selecting the Query button located in the bottom left corner, the table is re-populated with the
entries that match the queried information.

The user can then single-click any entry and hit Submit to automatically populate the Imaging
Information Editor with the patient information.

NOTICE: The user may also double click any entry within the table to quickly go into the Imaging
Information Editor without having to press Submit.

The Imaging Information Editor (Patient Information Dialog) will open. See Figure 5.3.3.
Complete remaining required fields and click on Accept to proceed to image acquisition.

5.3.1
Select from Work
List

Figure 5.3.2
Modality Worklist Search Dialog
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Note: Required Fields are indicated by a white asterisk (*). Default required fields are: Patient 5.3.1 Cont.
Name, Patient ID, Accession Number, and Laterality.

The user must enter all required fields prior to
being able to select the Accept button. The
user may also enter a Date, Referring
Physician, Procedure Name, Sex, Technician,
Position View, Body Part, and Study ID if so
desired. The Procedure Name, Position View
and Body Part are chosen by a drop down
menu.

Note: The Date must be entered as
yyyy/mm/dd (e.g. 1962/08/13). Failure
to enter a valid date may cause errors
when attempting to retrieve images.

Note: The "required fields" may be altered or
deleted depending on the application.
Contact Faxitron support for further
information.

Select Accept to continue or Start a New
Patient or Procedure to return to the Patient
Data Entry page.

Patient Name:

Patient ID:

Accession #:

Date of Birth:

Sex:

Procedure Name:

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

e 1 o |

L JD4567
L 918273

1920/03/20

*

=
A4 o

Start a New Patient or Procedure

Continue with Current Patient

Click on this button to continue with current patient procedure. The “Image Information
Editor” will open. See Figure 5.3.3. Follow the above procedure and notes.

Manual Entry

Click on this button to manually enter a new Procedure. The “Imaging Information Editor” will
open. See Figure 5.3.3. Follow the above procedure and notes.

Figure 5.3.3
Imaging Information Editor

5.3.2
Continue with
Current Patient

5.3.3
Manual Entry
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Select from Database 534
Choosing the Select f Datab butt ill display the followi See Fi 534 Select from
0o0sing the select Trom Database putton will display the toliowing page. see Figure o.o.
below. Database
Search Parameters: 00004 03205906 HOUSTON CARLA 2019/04/17 17:35... 1732/04/31 F Figure 5.3.4
Patient ID 00001 AV35671 KRISTY KAITLYN |67u/v03104 F Se/eCtlng Patlent from LOC&/
S 00002 Av3s672 GARCIA MARIA 1678/03/0¢ : Database Entries

00003 AV35673 SMITH MARY 1678/03/04
First Name

Middle Name
Time Modified

Date of Birth

NOTE: All patient data is fictitious.
Any resemblance to actual persons is
strictly coincidence.

I g

The user selects patient from the table on the right side of the page and then clicks on the
Accept button which opens the Image Information Editor. (Note: The user may also double
click the entry in the table to open the Image Information Editor.) Then follow the procedure
and notes on page 5.7.

Note: Use the scroll bar at the bottom of the screen to view hidden patient information.
Vision allows the user to narrow the patient list by entering specific information in the “Search

Parameters” window on the left side of the page. Only those patients matching all search
parameters will be displayed.
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If the user wishes to change or view the information after it has been input, but 535

before an image has been taken, they may press the Patient Data icon in the top

left corner. See Figure 5.3.5.

=

Patient Data Icon

Figure 5.3.5
Patient Data Icon

The Patient/Imaging Information Editing window will open. This editing window will be populated
with all the information that was previously entered/selected. See figure 5.3.6. Note: The Editing

window will now include a Cancel button.

The user can change or add information as
desired then click on:

e The Accept button to save the changes and
continue to image acquisition.

e The Cancel button to cancel changes and
continue to image acquisition. The software
will revert to the original patient information
entered, or

e The Start a New Patient or Procedure
button which will return the user to the Patient
Data Entry Screen. See Figure 5.3.1.

Patient Name:

Patient ID:

Accession #:

Date of Birth:

Sex:

Procedure Name:

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

8
o
i

LN Jane
L JD4567
LN 918273

1920/03/20

*

e
T
T
Fomme ¢
I
I
I
———
——
———
—
 ——

>

9]
o
a3
o
(L8

Start a New Patient or Procedure

Once the user clicks the Accept button the system is ready for image acquisition/x-rays.

Figure 5.3.6
Image Properties dialog

X-rays are started by pressing the green Start button on the front of the Faxitron Path cabinet
or clicking on the Start X-Ray button in the lower right corner of the screen. See Section 4.2.0,
Image Acqusition. The system will take a short “sample” x-ray, or pre-shot (which is explained
in Section 5.4.4) followed by a longer exposure to acquire the image. The software will process
the image before it is displayed on the monitor screen. Once the image is displayed, buttons on
the left and right side of the scree, covered throughout this section, will be enabled.
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The user may view, but not edit, the patient

Patient Name: *

Jane

Patient ID: " JD4587

Accession #: £ N 918273

information after acquiring an image by clicking on  JEECHEILE 1920/03/20

the Patient Data icon shown in Figure 5.3.5. This will  [S588
display a modified Patient Information dialog box as
shown in Figure 5.3.7. this box provides two buttons:
Close Dialog or Start a New Patient or Procedure. |[FSSSSiSss

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Techniclan ID:

Study Name:

Study ID:

Close Dialog

< Start a New Patlent or Procedure

Once an image is taken, the current image properties can be viewed by pressing
the (i) icon in the top-right corner. See Figure 5.3.8. The Image Properties Dialog
box will be displayed in the top=right corner of the image. The box is semi-
transparent to allow one to see what's underneath the box. See Figure 5.3.9

1.000%

2017/08/14 16:12:18 Monday

28.0 KV, 1.00 mA, 3.73 mAs

120170814161218.dcm

C:\Bioptics\Datal

Faxitron Bioptics

5.3.5 Cont.

Figure 5.3.7
Patient Information Dialog after
Image Acquisition

Figure 5.3.8
Image Properties Icon

Figure 5.3.9
Image Properties Dialog (View
Only)
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Vision software provides various tools and menus to control various image attributes or 54.0

parameters, x-ray acquisition, image views, image tools, and DICOM settings/access. The most Tool Bar and
commonly used tools are in a Tool Bar. The Tool Bar and Menus are described in more detail
in the following pages. Menus

Vision software provides single click access to a number of commonly used tools or functions 5.4.1
with a vertical tool bar located on the left side of the screen. More detailed descriptions follow Side Tool Bar
in the next pages. See Figure 5.4.1.

Figure 5.4.1

View / Change Patient Information NOTES: Side Tool Bar

(See Section 6.3.5 and Figure 6.3.5)

The following tools are always active
in the image acquisition page:

¢ View/Change Patient Information
e Exposure Control,

e Back to Main Menu, and

e Shut System Down

Enhance Image Icon

Window Level and Contrast Tool The following tools will be disabled
after patient data entry and will only
be enabled after an x-ray image has
been acquired:

Enhance Image,

¢ Window Level and Contrast,

¢ Digital Zoom, and

¢ Annotation

Digital Zoom Tool

Annotations Tools

The PACS Save and PACS Print
tools are only enabled after an x-ray
image has been acquired and when

PACS Save the system is connected to a PACS
network.

PACS Print

Exposure Control (Device Control Panel)

Back to Main Menu

Shut System Down
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Enhance Image

The button shown in Figure 5.4.2 will process the image on the display to emphaize the smaller
details, such as micro-calcifications, and small masses in the image.

/4(

The algorithm, commonly known as “Peripheral Equalization” or “Thickness Equalization” in
advanced imaging, is applied to the whole image. In addition to this algorithm, Faxitron employs
a second, internally developed algorithm called the “Calcification Emphasis” algorithm. This
secondary alrorithm was made to bring out small details in the image and make them much
easier to see and analyze.

Since Patient images constitute a more general category, in terms of possible geometries and
variety of thickness, there may be some challenging sample geometries, and the user should
use this tool with care.

The system will be idle (in Standby) during the processing. Once completed the button will stay
depressed/active. The user can undo the process by pressing the button again.

5.4.1 Cont.

Figure 5.4.2
Image Enhancement icon
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Inveting, Window Level and Contrast Adjustment 5.4.1 Cont.

The button, shown in Figure 5.4.3, will open the Window Level and Contrast adjustment tool.
This tool allows the user to adjust the image’s window level and contrast. The user may also
restore the Original Contrast by pressing the Original Contrast button, or invert the image by
pressing the Invert button. Inverting flips the color scheme from being predominantly black to
being predominantly white and vice versa. See Figure 5.4.4 below.

Figure 5.4.3
Window Level and Contrast Tool
icon and Controls

The user may also adjust the slider bar for desired
image contrast by clicking on the bar and moving it
up and down or by clicking on any of the indicated
arrows on the bar to move the lower or upper window
level limits. See Figure 5.4.3 (Informally this is also
known as "Window Leveling.").

Q

1650

Original Contrast

An example of inverting is shown below:

Figures 5.4.4

Example of inverting with the
Adjust Contrast and Window
Level tool

HOLOGIC

FAXITRON PATH USER MANUAL | HOLOGIC | REVISION 022 5-13




SECTION

Faxitron Path VISION

Specimen Radiography System Software

Dynamic Zoom Adjustment

The Zoom Tool icon, Figure 5.4.5, will open the Zoom Adjustment tool. After opening this tool,
the user may use the slider bar to adjust the zoom level, click the button to Fit to Specimen,
Fit to Screen, or Zoom 1.0x (full resolution). See Figure 5.4.6. When the image has been
zoomed in, panning is necessary to navigate around the image. A thumbnail dialog will appear
in the top left corner of the screen, See Figure 5.4.7 below. Click and hold the left button over
the image and move the mouse to move the image around in the main screen.

Note that traditionally, this feature is also called "Pan View" and/or "Pan and Scan.”

ZOOM LEVEL *
——  3.00x
—  1.00x
—  010x
The Fit to Specimen button will attempt to detect and zoom in 0.44
onto the specimen as to ensure that the specimen is in full view. o —
If a specimen is not detected, it will default to the previous mode
(either “Fit to Screen” or “Zoom 1.0x”).
|
Fit to Screen fits the image to the screen.
Zoom 1.0x is traditionally called “Full Resolution” as it brings the
image to a 1-1 view with the monitor resolution.

Cancel oK

5.4.1 Cont.

Figure 5.4.5
Zoom tool icon

Figure 5.4.6
Zoom Level Adjustment tool

Figure 5.4.7
Pan View example (left)
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Annotation

The button shown in Figure 5.4.8 will open up the annotation tools. These tools and
their many features are discussed in further detail in section 5.8.0.

PACS Store

The button shown in Figure 5.4.9 will only function when the system is installed in a
medical facility with a PACS network. To save your files locally, please refer to

section 5.7.0.

PACS Print

The button shown in Figure 5.4.10 will only function when the system is installed in
a medical facility with a PACS network. For local printing please refer to section

5.7.0.

Device Control Panel

The button shown in Figure 5.4.11 will open the Device Control Panel, which allows
the device user the convenience of controlling the X-Ray system through the
software. The user can easily select the Exposure Mode, X-Ray Tube kV settings,
Exposure Time, and the number of images to acquire for Image Averaging (if

desired) and initiate X-Ray exposure.

NOTE: The status, or availability, of the Exposure
Settings is indicated by the up/down arrows
adjacent to the setting. The arrows will be white for
active settings and light blue of inactive settings.
The Exposure Settings that are active is dependent
on which Exposure Mode is selected.

Figure 5.4.12 to the right shows Full Auto mode has
been selected and that kV, Time, and Image
Averages are all active. The user can adjust each
of these settings.

Note that the mA setting in the Faxitron Path
system is not adjustable via the software. The mA
settings will show as inactive.

When finished click on the Request X-Rays button
to acquire an image, or the Set button to save the
settings and close the Device Control Panel.

If the Cancel button is clicked the Device Control
Panel will close without saving any of the changes.

@ Full Auto O Auto kV
O Auto Time

26
3.00

0.40

Image Averages

Request X-Rays

< Cancel

0 E

O Full Manual

5.4.1 Cont.

Figure 5.4.8
Annotations icon

Figure 5.4.9
PACS Store icon

Figure 5.4.10
PACS Print icon

Figure 5.4.11
Back to Procedure icon

Figure 5.4.12
Device Control Panel
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Back to Procedure

The button shown in Figure 5.4.13 exits the image acquisition mode and returns to the
Main Menu screen.

Shutdown

The button, shown in Figure 5.4.14 will exit the software and shut down the system.

Additional dialog notes

When a dialog is opened, it is “docked” to the left side of the screen. If a user wishes to un-dock
the dialog box, they may click the top-right “Pin” icon to undock the dialog box and be able to
drag the box freely. The “pin” then tumns into a “X” icon allowing for quick closing.

Users can also quickly navigate between the various dialogs by clicking through the left menu.
By doing so, the left menu will quickly close and open the applicable dialogs as appropriate.

Top Menu Bar

The software provides access to “View”, “Tools”, “Image Tools”, “DICOM Ultilities” and “Help”
menus through a Top Menu Bar. See Figure 5.4.15. The Top Menu Bar is hidden by default
and is displayed by clicking on the Arrow button in the top right corner of the screen. See Figure
5.4.16. The Arrow button will be black or white depending on the software page/screen
background. Each menu item is covered in detail in the following pages.

DICOM Utilities

~

File Edit View Tools Image Tools Help

Note: The arrow will point down when the Top Menu is hidden and will
point up when it is displayed.

View Menu

The “View” Menu is located in the top Main Menu and contains the subOmenu items shown in
Figure 5.4.17 below. Each sub-menu item will be described in more detail in the following pages.

[EEI Tools Image Tools DICOM Utilities Help

Zoom Mode » NORMAL (FULL RES.)
Image Averages ADJUST ZOOM
Image Perspective FIT TO SAMPLE

Grid Options v HTALL

User Window Levels FIT WIDTH

Default Window Level FIT HEIGHT

Default Aspect for Raw Files
Enhanced Image
Sample Viewer

Magpnifier Size

vy v v v v v v v v v

Review Layout

5.4.1 Cont.

Figure 5.4.13
Back to Home Menu icon

Figure 5.4.14
Shutdown System icon

5.4.2
Top Menu Bar

Figure 5.4.15
Top Menu Bar

Figure 5.4.16
Top Menu Bar buttons

5.4.3
View Menu

Figure 5.4.17
View Menu
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Zoom Mode 5.4.3 Cont.

Normal

Displays the acquired image in its native format. The image in Faxitron Path systems exceeds
the monitors display area. A thumbnail dialog box will be displayed in the top left corner of the
image which allows the user to “pan” the image. Refer to Dynamic Zoom Adjustment in Section
54.1.

Adjust Zoom

This option is greyed out and is not available at this time.

Fit to Sample

This option adjusts the acquired image to best fit the specimen sample within the monitors
display area.

Fit All

This option displays the entire acquired image, regardless of its native format. The Full
Resolution option does not work in this view mode.

Fit Width

This option displays the acquired image across the available width of the entire display area.

Fit Height

This option displays the acquired image across the available height of the entire display area.

Image Averages

This option allows the user to adjust the number of image averages to be taken per an
exposure. The available options are 1x, 2x, 4x or 8x shots. Default setting is 1x Shots. If the
user selects 2, 4 or 8 shots the software will acquire the number of images selected back to
back with a single push of the Start button and average those images into a single image.

Image Perspective

This option allows the user to rotate the displayed image to 0, 90, 180 and 270 degrees in
orientation.

HOLOGIC

FAXITRON PATH USER MANUAL | HOLOGIC | REVISION 022 5-17




SECTION

Faxitron Path VISION

Specimen Radiography System Software

Grid Options

When an image is displayed, either as an acquired image or a retrieved image from the
database, the user may activate a grid. Also allows the user to set grid spacing (pitch). See
example below.

User Window Levels

This allows the user to define up to three (3) pre-defined, user set Window Levels (WL). First
select the Window Level button. Adjust the WL to the desired level. From the “View” tools,
select the “User Window Levels”. Select “Record Current WL as USER WL #1, #2 or #3”. The
adjusted WL will be saved under the choice previously selected.

Default Window Level

The user has two choices of “Default Window Levels” (WL). “Optimize for whole area”, which
adjusts the WL for the entire image, or “Optimize for sample”, which adjusts the WL for under
the sample area only. Additionally, there is an option to set the “Default Window Level” which is
used for all obtained images located here as well. This will set the default window level based
off of the image statistics and will need to be done for the un-enhanced and enhanced images
separately.

Default Aspect of Raw Files

This tool is placed under the VIEW menu. It helps importing/opening of previously saved image
files with unknown file attributes or binary image data without any header information. Since,
exact imager array size is not available from header of image data file, a closest fitting imager
dimensions will be used to import/open such images, based on width being larger or smaller
then height (default aspect information).

Enhance Image (same as the Enhance Image Button)

Processes current Patient image and enhances visualization of tissue located near the
periphery of the sample.

5.4.3 Cont.

Figure 5.4.18
Sample grid display
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Sample Viewer 5.4.3 Cont.

In the event that the system has a web camera, this toggles the systems’ web camera viewer
to allow the specimen orientation and alignments.

Review Layout

Helps user configure multiple image panes in the Review (Database) Mode of program.
Available options are “(1 X 1) Single”, “(2 X 1) Double H”, “(1 X 2) Double V”, “(1 + (2 X 1) Triple”
and “(2 X 2) Quadruple” layout. During multiple pane operation, the user can click on desired
pane/image once to make it current selection, the current selected pane will get green
rectangular border around. The images in database list view or database thumbnail view will be
opened into current selected pane when double click on them. User can also open the images
into desired panes directly from right click menu of the mentioned database views After right
click menu activated, the user can select from the panes listed under OPEN TO- which will
provide available panes to open the image into (left, right, top, bottom etc.).

Tools Menu 5.4.4
. : : Tools Menu
The “Tools” menu is located in the Top Menu Bar, found in the upper left hand corner of the
main screen.
IS ¥mege Yool DNCOM Utities: Help Figure 5.4.19

e Tools menu

Sernice Mode

Advanced Tools ’ AUTO SAVE ON/OFF »

PROPERTIES EDGE SUPPRESSION »

TILE SUPPRESSION »

XRAY ColbeationvExposure Setup
PRESHOT AEC Exposure Setup
IMAGE ENHANCEMENT Setup

DELETE Current Image Recced
ADD  Current Image Recoed

CAPTURE Screen Shot IPG/EMP

Login Utikty
Save/Store current image ’ Cyfic Atomated Acquiitsons
Priet cunrent image 0 OTHER ADVANCED User Tocls »

Preferences

The “Preferences” menu opens a configuration management utility which can be used to change
various options or parameters.

NOTE: The “Preference” tool option is password protected and should only be accessed by an
authorized Faxitron service representative.

NOTE: Changing configuration parameters without proper knowledge or authorization can
cause loss of image quality, system damage, and system malfunctions.

Service Mode

The “Service Mode” is password protected and turned on by Faxitron authorized technicians for
troubleshooting purposes.

Service Tools

“Service Tools”is normally greyed out. Itis only turned on when the system is in “Service Mode”.
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Save Reference Files

“Save Reference Files” is normally greyed out. It is only turned on when the system is in
“Service Mode”.

Advanced Tools Option

The Advanced tools offer various options to configure aspects of the software such as post-
processing and configuration options.

Auto Save On/Off

When “Auto Save” is “on”, all subsequently acquired images are saved to the database. The
files are written to a Data Directly defined in the configuration file.

X-Ray Calibration/Exposure Set-up

This is placed under Advanced Tools. The “X-Ray Calibration/Exposure Setup” aids the user in
determining the proper exposure time for a selected kV setting for best image quality. Please
refer to section 5.2.0 and 5.2.1 for a more detailed description.

Preshot AEC Exposure Setup

The Faxitron Path system utilizes Automatic Exposure Control (AEC) to provide the best
possible image quality with a single press of the Start X-Ray button. The software utilizes a
Preshot exposure to calculate the optimal exposure kV and time settings. The Preshot s a short,
typically 2-3 seconds, x-ray exposure. The software analyzes the results to determine the kV
and time needed to produce the best image quality. The Preshot AEC Exposure is configured
at the factory and is turned on by default.

“Preshot AEC Exposure Setup” allows the user to adjust the system for particular imaging
requirements or to compensate for system aging.

To access the “Preshot AEC Exposure Setup” dialog go to the Top Menu Bar, select “Tools”,
“Advanced Tools” the “PRESHOT AEC Exposure Setup”. See Figure 5.4.19

5.4.4 Cont.
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Enter the PRESHOT AEC values in
the window shown at right.

The settings shown reflect a 26 kV
and 3 second exposure time with a
target intensity of 10,000 ADUs for
the pre-shot setting. Users can enter
the selection of pre-shot parameters
only with the selection of DYNAMIC
METHOD in the ANALYSIS
METHOD section. The STATIC
METHOD selection will use Faxitron
predefined parameters. In addition,
the user has the option of selecting
the kV and exposure time settings
from the EXPOSURE TUNING
METHOD section.

For more accurate images, the user

can enter the SOFT TISSUE
(Sample) thickness and the
TARGET INTENSITY in ADUs.

NOTE the values int eh above
image are an example only. The
correct value needs to be
determined.

Note: The values in the above
image are typical for the Faxitron
Path system. The exact values for
your system need to be determined.

Software
5.4.4 Cont.
PRESHOT - AEC ON/OFF PRESHOT ANALYSIS METHOD .
B RN O FritorioT oAt o Dewcwerioo Figure 5.4.20
* [Aequi t % l d .
T aae e Sela Sy . ey e Preshot AEC Setup dialog box

(go!
DYNAMIC PRESHOT PREFERENCES
PRESHOT kv DESIRED [(kv]  [260
PRESHOT TIME DESIRED [s]  [3.00

PRESHOT COMBINATION I[1]NDNE,DISCAHD PRESHOT, SHOW AEC SHOT ALONE LJ

EXPOSURE TUNING METHOD
& AUTOKY ZAUTOTIME AUTO KV / FIXED TIME

7.30
THICKNESS/BEAM HARDENING /OVERBURN

jv AUTO DETECT SAMPLE THICKNESS
FROM PRESHOT/PRELOADED IMAGE

€ FIXED KV / AUTO TIME
45.0

[v ENABLE OVERBURN PROTECTION

* Preshot and AEC shot are
assumed to have similar
sample+tray thicknesses

ENTER SOFT TISSUE EQUIVALENT
SAMPLE+TRAY THICKNESS

[0] 0.00"=0.00cm

TARGET INTENSITY
*GENERAL RECOMMENDATION: Use

ENTER DESIRED MEAN 60-90% of Mean Flat Field Value F
INTENSITY UNDER SAMPLE [apuj  |10000.0 SEiotetoy Bt S

oo

For the AUTOMATIC EXPOSURE CONTROL mode, push the Start button within the Vision
software (or on the Control Panel). The Vision software will perform a pre-shot (a short, low
dose, pre-exposure) of the sample to create a Region of Interest (ROI) for obtaining the
exposure parameters for the optimum image exposure.

Login Utility

The Login Utility is under the ADVANCED TOOLS menu and allows the user to configure and
activate the start-up password authentication for Vision software. Activation of this feature is
optional on the Faxitron Path system. If the user activates the password authentication they will
be prompted for the password each time the program is opened. The program will close if the

correct password is not entered.

Current Password:

NEW PASSWORD |
CHANGE
REENTERNEW |

PASSWORD:
PASSWORD

AUTHENTICATE

OPTION: IV Enforce User Authentication on Software Startups

Apply Changes

Figure 5.4.21

Login Utility. Same screen
will appear during
authentication at the
startup.

HOLOGIC

FAXITRON PATH USER MANUAL | HOLOGIC | REVISION 022

5-21



Faxitron Path

Specimen Radiography System

SECTION
VISION
Software

Properties

“Properties” hides or shows the Image Information Box. See Figure 5.3.9.

Edit Current Image Record

Currently not used.

Delete Current Image Record

Deletes the current image from the file directory as specified in the configuration file.

Add Current Image Record

Adds the current image to the file directory as specified in the configuration file.

Capture Screen Shot JPG/BMP

By selecting this menu choice, the user can do a screen capture of the displayed active
window. The user can specify a file name and choose between JPG and BMP as the saved
file format.

Save /Store Current Image

The user may “browse” to the directory or file folder to which the image is to be saved. A file
name must be assigned in the field provided. Select a file type to save the image as. There
are many file types provided. To save the file in a DICOM format, please refer to the “DICOM
Functionality” section.

Print Current Image
Prints current image to the WINDOWS printer.

Image Tools

The following features are available to edit the acquired or retrieved image by clicking on the
“Image Tools” menu. See Figure 5.4.22. The sub-menu options are activated or accessed

with a single click on the desired option.
LRSS DICOM Utilities

5.4.4 Cont.

5.4.5
Image Tools

Figure 5.4.22

Original Contrast
Invert

Magnifier
Enhance

ROI Contrast

ROI Window Level
Ruler

ROI Statistics

ROI Histegram
ROI Profile

Line Profile

Image Tools Menu
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Original Contrast 5.4.5 Cont.

“Original Contrast” restores the image contrast levels. This serves the same purpose as the
Original Contrast button in the Window Level and Contrast tool. See Section 5.4.1 and Figure
5.4.3.

Invert

‘Invert” causes the displayed image to become inverted or reversed. Inverting as image
reverses its transparency: what is black becomes white and what is white becomes black. Grays
are assigned their mirror transparency. Click “Invert” again to turn off the feature. Performs the
same function as the Invert button. Refer to Section 5.4.1 and Figures 5.4.3 and 5.4.4.

Magnify

“Magnify” allows the user to magnify an area of interest. To use the Magnify feature, place the
mouse cursor over the desired area to be magnified and click the left mouse button. The area
of interest will be magnified. Click “Magnify” again to turn off the feature. Refer to Figure 5.4.23.
The size of the magnified area of interest can be adjusted by the user. Refer to the “Magnifier
Size” sub-menu in Section 5.4.3.

Figure 5.4.23
Magnify

Edge Enhance

“Edge Enhance” will create a sharper definition around edges of regions with a contrast
difference. Edge Enhancement may amplify the noise in the images in general. Selecting the
menu item again will turn off the edge enhancement. Clicking on “Original Contrast” will also
restore the image back to its original state. Note this is a different feature that the Enhance
Image feature in Section 5.4.1 and 5.4.3.

ROI Contrarst

“ROI Contrast” will optimize the contrast levels within a user-defined region of interest (ROI).
After selecting the “ROI Contrast” click and hold the left mouse button at the starting point of
the desired ROI, drag the mouse and release the mouse button at the desired ending point of
the ROI. The contrast will automatically adjust to the best levels for that ROI. (See the
Definitions section for ROI).

ROI Window Level

the “ROI Window Level” function is not available in the current version of Vision software.
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Ruler

5.45 Cont.

“Ruler” allows the user to measure the distance between two points in the displayed image.
Length measurements are in millimeters (mm). After selecting “Ruler” click and hold the left
mouse button, starting at the beginning point of measurement, drag the mouse and release the
mouse button at the ending point of the measurement. The Ruler is displayed as a red line on

the image.

The measurement (in mm) is
displayed at the end of the ruler.
The Ruler remains active until the
user selects another image tool or
until another action is performed.
See Figure 5.4.24 to the right. Click
“Ruler”again to turn off the feature.

Hint: To get a perfectly straight
line, or a line at a perfect 45 degree
angle, hold down the SHIFT key
(on the keyboard) while holding
down the left-mouse button and
drag.

ROI Statistics

Figure 5.4.24
Ruler

“ROI Statistics” will display a dialog box containing image statistics. Click and hold the left
mouse button over main image’s region-of-interest (ROI), drag cursor to make selection around
area, and then release the mouse button. Statistical information for the selected region will be
displayed on the left side of the dialog box and for the whole image on the right side of the box.
The stats displayed are: the beginning and end points of the ROI, Minimum, Maximum and
Mean intensity values, and Standard Deviation (STD). To close the Statistics information box,
simply click on the Close button. See Figure 5.4.25. Click “ROI Statistics” again to turn off the

feature.

Selected Region

Figure 5.4.25
ROI Statistics

‘Whole Image

(Top.Left)=(583,13989)
[Bottom, Right)=(1189,2558)

Minimurm:616
Maximum: 7537
Mean:5620.00
STD: 955.60

(Top.Left)=(0.0)
(Bottom,Right)=[3072,3388)

Minirmurn:523
\Maximunm:14042
Mean: 9606.26
STD:4026.28
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ROI Histogram 5.4.5 Cont.

“ROI Histogram” will create a histogram for a user defined ROI. After selecting the menu item,
place the mouse cursor in the displayed image, press and hold down the left mouse button and
drag the cursor to make the desired ROI selection. Release the mouse button. Histograms for
the selected ROI will be displayed. See Figure 5.4.6.

The Black curve is the Histogram of the selected region. The Blue curve is the Histogram of the
whole image. Both curves are normalized against the peak maximum pixel value of the selected
region of interest. Click “ROI Histogram” again to turn off the feature.

Figure 5.4.26
ROl Histogram
Histogram
100.00
90.00
%»( 80.00
[ 70.00
o 60.00
£ 50.00
% 40.00
; 30.00
E) 20.00
- I
Intensity \e;é\
ROI Profile
“ROI Profile” will create a profile for a user defined ROI. After selecting the menu item place the
cursor in the displayed image. Hold down the left mouse button and the move cursor across the
image to draw a user-defined box around the desired ROI. Release the left mouse button and
a profile will be displayed showing the individual pixel value of the defined ROI. See Figure
5.4.27. By default, the averaging direction of the selected ROI is the short axis. The axis may
be toggled back and forth by selecting the SWITCH, HOR<->VERT button. Click “ROI Profile”
again to turn off the feature.
Figure 5.4.27
ROl Profile

Horizontal Region Profile

7500.00
6850.00
6200.00
5550.00
4900.00
4250.00
3600.00
2950.00
2300.00
1650.00
1000.00

=
7]
e
o
=
©
o
B
2
<

Horizontal Axis of Region From (1875.840) To (3163,899)
SWITCH : HOR<->VERT | savEasTxT|  PRINT | [ cLose

HOLOGIC

FAXITRON PATH USER MANUAL | HOLOGIC | REVISION 022 5-25




SECTION

Faxitron Path VISION

Specimen Radiography System Software

Line Profile

“Line Profile” will display a profile for a user defined line. After selecting “Line Profile” place the
cursor in the displayed image. Hold down the left mouse button and move the cursor across the
image to draw a user-defined line. Release the left mouse button and a profile will be given
showing the individual pixel value of the defined line. See Figure 5.4.28. By default, the first
selected point is always the left most (near origin) portion of the plot (i.e. horizontal axis of the
graph can have increasing or decreasing pixel (i,i) indexes, depending on the selected start/end
points). Click “Line Profile” again to turn off the feature.

i Line Profile

| 7500.00
6800.00
6100.00
5400.00
% 4700.00
S 4000.00
S 330000
2600.00
1900.00
1200.00

S &8 § 8 8 8 B § 8 8 8

-~ o~ - < © ~ [se] » e ‘(\_J

Index on the Line From Point (2235.861) To (3362,858)
saveasTxr|  pAwt | [ ciose |

Built-In Window Level

Vision Software comes with a “built-in” Window Level feature. There is no button or menu item
to select it. The Window Level feature is automatically activated whenever an image is acquired
or retrieved from the database for review. This feature gives the user the ability to adjust the
image contrast and brightness levels using the mouse/cursor.

Click and hold the left mouse button over the displayed image and move the cursor up and
down for brightness/darkness levels or move the cursor left and right for low/high contrast. Move
the cursor until image is at desired levels.

5.45 Cont.

Figure 5.4.28

Line Profile
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By pressing the button, shown in Figure 5.5.1, located along the bottom of the image acquisition
window, the current patient images thumbnail strip appears. See Figure 5.5.2.

N

BROWSER

The thumbnail strip displays the Procedure date for each individual image series in orange text
along the top.

The current image displayed in the image acquisition window will be highlighted in green.

The thumbnail strip supports drag and drop operations to place images into the image display
or review panes as necessary.

In addition, with a single click, the user can select multiple images and then select from the
various options to Save the images to a USB drive, send the images to PACS, or delete the
images. Selected images are highlighted in orange.

There are arrows located to the left and to the right. In the event of many images being taken,
the user may traverse the images taken, date ascending, by pressing on the left/right arrows.

There is also an option to Open the Database (see Figure 5.5.3), which enters Review mode.
This same button is the equivalent of pressing Review Mode from the Home Menu. See Figures
5.0.1 and 5.6.1.

Review mode can be entered by clicking the Review button in the Home Menu page, Figure
5.6.1 and 5.0.1, or the Open Database button in the Current Image Browser. See Figure 5.5.3.
Clicking either of these buttons will open the Database as shown in Figure
5.6.2. The system will be in Standby while in review mode.

O

The Database is basically comprised of three sections or sub-windows. The Patient List Table
section, on the left, the Procedure List Table section, on the top right, and the Image Thumbnail
List/Viewer section, located bottom right.

5.5.0
Current Patient
Images Browser

Figure 5.5.1
Current Patient Images Browser
icon

Figure 5.5.2

Current Patient Images Browser

Figure 5.5.3
Image Database button

5.6.0
Database

Figure 5.6.1

Review Mode icon displayed on
the Home Menu.

Figure 5.6.2
Image Database
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The list tables work in top-to-down hierarchy as indicated by the arrow:
The Patient List--->Procedure List--->Image Thumbnail List/Viewer.

The Patient selection window is the upper left most window. The Procedure window is the upper
right most window.

When a Patient field is selected, the Procedure window becomes active. The Procedure window
displays a listing of all Procedures performed under the selected Patient. Additionally, all images
corresponding to the patient are displayed in the bottom right. It is not possible to select multiple
patients.

When a Procedure is selected, the image thumbnail list/viewer is filtered to only show the
images which correspond to the selected procedure. Multiple procedures can be selected by
holding the Shift key and left-clicking each procedure. All the images for the selected procedures
will be displayed accordingly.

e The database may have its sorting adjusted by clicking on the top fields such as Patient ID
and Last Name to sort by either one. When the mouse cursor is clicked over one of the
database fields, a small arrow indicator is displayed within the field. Using the Left Mouse
button and selecting the field again changes the arrow from ascending to descending or vice
versa. The field selected will be automatically sorted accordingly.

e Scroll bars are located in the database to allow for ease of navigation.

e The thumbnail list/viewer allows for a user to click on the “+” symbol to automatically add the
image to a review pane. A user may add up to four images into the review panes. The review
panes are automatically adjusted to encompass the four images.

e The same options as available in the Current Patient Images Browser (see Figure 5.5.2) are
also located at the top of the Database. However, additional options are also made available,
described in section 5.5.2.

Important Note: The “thumbnail” images (.PNG) are separate files from the actual image data
(DCM, DAT, DMM, RAW) files. They have the same file name as the image file, but they have
a (.PNG) file extension. It is possible to have an image file and no “thumbnail”. In that event,
Vision will attempt to create a thumbnail automatically for the image to be loaded into the
database. However, if this is unsuccessful, the image will not be displayed.

Save Image(s)

The Save Image(s) button is available when an entry from the Image Table or Thumbnail List
is selected, or through the current patient images, otherwise it is disabled. The selected image
can be saved in the following popular 8-bit formats: JPEG, BMP, TIFF and RAW. It can also be
saved in 16-bit TIFF format.

The window level of the saved image is the default window level. If the user requires that the
window level be arranged, he/she should load the image to the Image View and print from there
rather than printing from database dialog.

Send Image(s) to PACS:

This function sends the image(s) to a pre-configured DICOM PACS Server. Refere to Section
5.7.0 for more information.

5.6.0 Cont.
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Image Database Menu Functions and Tools

There are functions to navigate, search in the database, and
to edit, delete, and add records to the database. Those ADDITIONAL OPTIONS
functions are explained through database menu items. They
are accessed from the top level button labelled Additional
Options within the database.

Open
Print

View
Search
Tools

Close Database

Open Menu

The “Open” Menu has only one option “Open Image from File” which opens a Windows dialog
box that allows the user to navigate to and open image files located on local or network drives.

Print Menu

The “DB-PRINT” menu provides for Image/Procedure/Patient print functionality. See Figure
4.6.4.

>

o Print Image to Local Printer
’ Print Image(s) to DCM Printer

Print Image to Local Printer

“Print Image to Local Printer” is available when entry from the Image Table or Thumbnail List is
selected, otherwise it is disabled. The selected image will be printed using the local default
printer of Windows system.

The window level of the printed image is the default window level. It is not recommended that
users Print from this menu, unless they are satisfied with the print outs set to the default window
levels as calculated by the program. The user can load the image first into the Image View
(Review) window and then adjust the image to the desired window levels. When satisfied with
the window level, the user can then initiate Print from the menu of Image View window. A Format
Options dialog provides a choice between printing formats.

Print Image(s) to DCM Printer

This function sends the image(S) to a pre-configured DICOM printer.

View Menu
The “View” Menu provides the user a number of options affecting the Database view. See Figure
5.6.5

Print
Show All DB Entries
Search Refresh DB Entries

Tools Browse Data Dir. (No DB)
Browse Any Dir. (No DB)

5.6.1
Database
Additional Options

Figure 5.6.3
Additional Options Menu

Figure 5.6.4
Database Print Menu

Figure 5.6.5
Database View Menu
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Show All DB Entries

Reloads the Patient table from the Database file. Any new changes or additions to the Database
will be applied to the table. This selection also clears any active Search Filter which may have
been applied to the tables. Search Filter is explained in detail under the Database Search
subject below.

Refresh DB Entries

Refreshes the Patient table, but maintains any existing Search Filter that has been applied.

Browse Data Directory (No DB)

Displays all thumbnail images in the Data directory established by the configuration file. These
files are displayed in the Thumbnail Viewer. They are not associated with the Database, or table
lists. This tool is helpful to review un-recorded images, or to debug database problems with
images in the current data directory.

Browse Any Directory (No DB)

Allows user to browse to any file directory. These files are displayed in the Thumbnail Viewer.
They are not associated with the Database, or table lists. This tool is helpful to review an image
directory which was never recorded in the database, or when database records are corrupted.

Search Menu

The database “Search” tools, see Figure 5.6.6, provide detailed searches or database filtering.
Selecting the “DB-Search” menu allows the user to perform a detailed and specific search.
When search criteria is entered and activated in the DB Search Dialog, see Figure 5.6.7, the
search filter is applied to all list tables on Image Database dialog. The activated search criterion
is called “Search Filter” and this filter remains effective until the user selects “stop Search” from
“DB-Search”menu or “Show all DB Entries” from the “DB-View” menu. The active “Search Filter”
is always shown in the caption of Image Database dialog.

) Start Search
Stop Search

Start Search

“Start Search” opens the DB Search Dialog which allows the user to place an active Search
Filter on the database. When the Search Dialog is opened, the Database page is closed and
the software goes back to the Image Acquisition page. The Database page will reopen
automatically after the Search Dialog is closed.

SEARCH BY: Enter ACCESSION NUMBER
|[AccessionNumbel] _:J |

CLICK -OK-TO ACTIMATE SEARCH FILTER ON THE DATABASE

oK I Cancel I

Drop down menus provide a listing of the search categories. Select a search category and type
in the desired search parameter to start the search. Select the “Start” to initiate the search. If
the category can have more than one discrete entry, all entries for that category will be
displayed.

5.6.1 Cont.

Figure 5.6.6
Database Search Menu

Figure 5.6.7
Starting a DB-SEARCH
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Stop Search

“Stop Search” disables any active Search Filter, clears all list tables, and re-loads the list of all
Patients to Patient List Table.

Tools Menu

The “DB-Tools™ menu provides per Image/Procedure/Patient functions as well as some useful
functions to repair or reformat the database.

View

Search

Edit Image Record

Glose Database Add Record to DB

Import Records in DIR to DB
Reformat All DB

Edit Image Record

The “Edit Image Record” function is not currently available in Vision software.

Add Record to DB

Available when entry from Image Table or Thumbnail List is selected, otherwise disabled. This
is especially useful when a directory is browsed without database having entries available for
images in that directory. The user can select a single image from the thumbnail list and add
records of that image into the database. If the database entry already exists for the selected
image it will not do any harm, it may only update the database in terms of where the image file
is currently located i.e. file/folder name.

Import Records in DIR to DB:

This tool helps to browse and select a folder, and then to populate the database with all the
corresponding entries for all the image files under the selected directory (including
subdirectories). The formats for images can be DCM, DAT, DMM and RAW. If thumbnails or
images are missing, this tool will also generate BMP thumbnails in the same directory.

Reformat All DB:

“Reformat All DB” tool helps to reformat Date [YYYY/MM/DD], Date/Time [YYYY/MM/DD
HH:MM:SS] fields of tables, and also capitalizes letters of entries for some other fields. It is a
useful tool when some older database file is imported and opened for the first time, or when the
user alters database entries manually using MS Access.

Additional Notes on the Database

e The ability to Exit the database, staying within the Review mode, is located under Additional
Options.

e The top-left button will adjust itself to take the user Back to Acquisition, Back to the Main
Menu, or will become the Close Database button, dependent on the workflow used to enter
the Database screen, and what is most appropriate.

5.6.1 Cont.

Figure 5.6.8
Database Tools Menu
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Edit or Delete Patient Information from the Database 5.6.1 Cont.

The user may edit or delete patient information from within the database. Right click on the
patient’s entry in the top section of the database to open a Dialog box. See Figure 5.6.9.

JD6758 DOE JEN 2019/03/2

JD56 DOE JAN 2019/03/2

Patient Name:

* TR
.

JD8679 DOE JANE

Edit Patient information /9

Patient ID:

Delete Patient Information
Date of Birth:

Save Changes >

<

Clicking on “Edit Patient Information” will open a
“Patient Information” dialog box. See Figure
5.6.10. Click Cancel to return to the database
without making or saving changes. Clicking Save
Changes will open a “Confirmation” Dialog box.
Click Yes to confirm and proceed. Changes are now saved and the user will be returned to the
database No will void the changes and return to the database. Cancel will return the user to
the “Patient Information” dialog.

Note: If the system has a start-up password activated (see the Login Utility topic in Section
5.4.4 and Figure 5.4.21), the same password will be requested when trying to “Delete Patient
Information” from the database.

The DICOM Standard
What is the DICOM Standard?

The Digital Imaging and Communications in Medicine (DICOM) Standard is a series of protocols
used by medical equipment and software to allow data to be compatible and interchangeable
with other medical equipment or software.

When a file is saved in a DICOM format, a file is created that includes relevant Patient data,
imaging equipment. hardware data, and image data, all in a single file. Additionally, the saved
file contains specific characteristics that identify it to computer and software as a DICOM
Standard file. Once a software application recognizes the file as a DICOM Standard file it can
initiate a DICOM reader and extract the data properly, regardless of the file’s origin.

A file created using the DICOM protocol has the following structure.

Preamble Header
Prefix
Data Element
. . Data Element
Where the Preamble consists of 128 bytes, all typically set to O0OH
unless it is not used by an Applicable Profile or a specific Data Flemen:
implementation; the Prefix consists of 4 bytes, making up the Data Element Diata Set
character string “DICM” encoded as uppercase characters of the Data Elemant
ISO 8859 GO Character Repertoire; and the Data Elements are
arbitrarily large (or small) and contain the data.
Data Element

Figure 5.6.9
Edit/Delete Dialog Box (Lefft)

Figure 5.6.10
Patient Information (Right)

5.7.0
DICOM
Functionality

Figure 5.7.1
DICOM Protocol Structure
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Modality 5.7.0 Cont.
The DICOM file settings for Modality are accessed from the Top Menu Bar by selecting “DICOM

Utilities”, then “DICOM Modality Setup”.
Help | Figure 5.7.2
DICOM MODALITY Setup DICOM Utilities menu
DUMP DICOM Header

The DICOM storage type, either Presentation or Processing may be selected. The same Dialog
box allows for selecting the DICOM Image Modality, either Digital X-Ray or Digital X-Ray
Mammography. The Transfer Syntax and Value Representation is not user definable. They are
always assigned to be META HEADER PRESENT, LITTLE_ENDIAN and VR_IMPLICIT.

Figure 5.7.3
DICOM Modality Settings

Default settings shown
DICOM Storage Type - Yalue Representation 9

% Storage For Presentation @ Implicit

(" Storage For Processing " Explicit*

DICOM Image Madality [~ Transfer Syntax

(¢ Digital X-ray Image (General) & Litle Endian

" Digital X-ray Mammography Image " Big Endian*

*) IMPLICITR and LITTLE-ENDIAN syntax is recommended. Other options may
not be fully compatible with third party software or DICOM services. IMPLICITR
and BIG-ENDIAN cannot be simultaneously selected.

- Default DICOM Servers
STORE1 |

STORE 2|
¥ Enable Single-Click Auto Store

PRINT |
[V Enable Single-Click &uta Print

MwL |

[V Enable Auto Search When Connecting to MWL Server
[V Enable Single-Click Auto MWL Connection

[ Autoclose dialog after I 5 seconds of successful transfer/printing.

Click DICOM Servers button to add, configure
DICOM Servers... | o delete DICOM servers.

V oK | Cancel

NOTE: Once the DICOM Modalities have been selected, they remain in effect even after the
Vision software has been closed. The Modality settings are stored and will remain in the
configured manner until they are changed again using the DICOM File Settings. These settings
(Storage Type & Modality, Transfer Syntax, and Value Representation) will be effective for all
DICOM Local Save or Print functionalities.
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Default DICOM Servers

This section contains settings for default DICOM servers and to automate some of the
processes when storing, printing or searching PACS and MWL servers.

“Enable Single-Click Auto Store”, “Print” or “MWL Connection” checkboxes allow user to store
or print images or automatically connect to the MWL server. If you use a single PACS server
for those actions or majority of your work involves a single PACS server, check a desired box
to automate those actions.

“Enable Auto Search When Connecting to MWL Server” will tell the application to automatically
perform a search with default search settings when looking up patient’s data.

“Auto close dialog after N seconds of successful transfer/printing” will automatically close the
DICOM Networking dialog after specified number of seconds passed. The dialog will not close
automatically if there was an error with transfer or printing.

Clicking the DICOM Servers button will open DICOM Networking dialog, where a user can add,
modify or delete DICOM servers. See Figure 5.7.5.

DICOM Save Local

To save the durrent image to a local drive/directory, right click anywhere in the image. This will
display the dialog box shown in Figure 5.7.4 below. Click “Save/Store current image” then “As
Local DICOM image”. This will bring up the standard Windows File Save Dialog. Browse or click
through to the desired directly/folder, enter the file name and click Save.

UEIELE CUlienL imaye recora

Add new record

Save/Store current image » LIS Archive image
Print current image » As local DICOM image

As local image

More options...

PACS STORE and PACS PRINT

The Vision software allows for PACS (DICOM) Store and PACS (DICOM) Printing. These
options are available throughout the software. For example, if the PACS Store button is
selected, the following DICOM Networking Dialog window can be displayed. This Dialog box
allows the user to do a DICOM Store, DICOM Print, or to Add, Modify or Remove DICOM
Network connections or Peripherals.

$% DICOM Networking Dialog - Biopt
SESSION SECURITY VIEW COMMAND PREFERENCES

| « | DICOM Network Connections

L T
MODIFY Session DICOM Store 1 DICOM Print 1 (Bt
REMOVE Session

ASSOCIATION List

Session

DICOM Network Messages Log

CLOSE

5.7.0 Cont.

Figure 5.7.4
Save Current Image Dialog

Figure 5.7.5

DICOM Networking Dialog box
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PACS DICOM STORE

The Vision software supports DICOM 3.0 C-STORE Service. This allows for sending an image
or a series of images (under a specified Procedure) to a remote DICOM Application Entity (AE)
compliant storage system such as PACS. Again, the DICOM Store capability is provided for
throughout the Vision software. Modifications to the Presentation and Processing may be made
through the DICOM Modality Setup, under the Tools menu.

Note: For DICOM Store, the “SET FILM Attributes” will be grayed out.

The user can add a new configuration for a remote DICOM AE to which to send the image or
select from an already configured one, shown under the DICOM Network connections, in the
DICOM Networking Dialog. By double clicking (or single click, followed by pressing the Connect
button) the icon for the remote DICOM AE, the Vision software will connect and establish a
DCIOM association with the selected remote AE. Once the association is successfully
established, the image can be sent for storage by pressing the Store button. After the Store
button is selected, the Vision software will send the selected image to the defined remote
DICOM AE. If the Store operation is successful, the remote DIOCM AE will send a confirmation
of reception and storage of the image(s). If the operation fails, the remote DICOM AE will send
an error code indicating the reason for failure.

A single image can also be sent for storage by clicking the Right Mouse button on the image
“thumbnail” while in the Database Browser and following the same procedure described
previously. It is possible to send a whole Series (Procedure) of images for storage. This is
accomplished by clicking the Right Mouse button on the Series (Procedure) name, displayed in
the Database Browser screen and again, following the same protocol described above.

Add Session

The Add Session button opens the Session Dialog box through which the user can configure
a new connection to a remote DICOM Application Entity.

To create a new connection configuration to a remote DICOM AE, the user must have the
following information available: the Application Entity Title (AE Title), the choice of DICOM /
PACS “function to perform”, the IP Address and the Port Number for the Server (i.e. the DICOM
printer or PACS system).

The AE Title and Port Number of the user’s system (i.e. the client) are also required. Complete
the appropriate data fields and select OK to create a new configuration.

Choosing DICOM / PACS Default Session Function Behavior

There are currently four (4) types of functions that a DICOM session can represent as a default.
These are found in the Function drop-down list (combo box) seen in the figures below. A list
also follows:

5.7.0 Cont.

1. A GENERAL DICOM / PACS Connection | % DICOM Session Properties &) Figuresrs
] Session Properties Dialog box
. A DICOM STORE Connection Nickname: | oK |

2
3. ADICOM PRINTER Connection
4. A Modality WORKLIST Connection

Server

Cancel |

AETite: |

Function: | GENERAL

STORE

IP Address:  |[PRINT
©5% NWORKLIST

Port Number: |0

Client

AE Tile:  |FAXITRON_DR

Port Number: |0
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The purpose of the DICOM “Function” is to allow a Session/Connection to be created (added)
that allows a DICOM / PACS “device” to only be used as the user has configured it for a
particular function category. Once configured, when you view or use the “DICOM Networking
Dialog,” (see figure 5.7.5 above) only the icon that matches the function chosen will be “active
and lit up.” That is, it will have a blue color as opposed to a “grayed out” color. For example, in
figure 5.7.5 above, we have three (3) icons representing, in order, a PACS Store (DICOM Store
1), a PACS Print (DICOM Print 1), and a Modality Worklist (DICOM-MWL). Because the DICOM
Store button was chosen previously it is the only one active (blue screen). It works the same
for the other modes as well.

Modify Session

The Modify Session button opens the Dialog box for the selected DICOM AE. In this window,
the user may modify the Server and Client information described in the Add Session description.

Remove Session

The Remove Session button removes the selected DICOM AE configuration from the Vision
software. Once removed, a DICOM AE configuration cannot be restored, unless the user
manually re-enters the requisite data through the Add Session button. A confirmation of action
will be requested, see below.

-
Vision -

l]&) Are you sure you want to remove this DICOM Network Connection?

5.7.0 Cont.

Figure 5.7.7
Verifying Removal of an Existing
DICOM Network Connection
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Association

5.7.0 Cont.

The Association List button opens the Association Dialog box, depicted below, through which
the user can edit the parameters and protocols used by the Vision software when negotiating a
connection with a remote DICOM AE. These options should only be modified by an advanced

user familiar with DICOM association protocols.

@ DICOM Assaciation

o

—

Version:

]1 .2.840.10008.3.1.1.1

16384 [V Enabled

Application Context:

Max Data Length:

Implementation Class: |1 .2.840.114257.1123456

Implementation Yersion: |1

Max Operation Invoked:
Max Operation Performed:

[” Enabled

Cancel

[V Enabled
[V Enabled

BDSuaC ke Verification Class

Basic Film Session Class
Basic Film Box Class

Print Job Class
Basic Annotation Box Class
Printer Class

Basic Grayscale Image Box Class
Basic Grayscale Print Management Meta Class

m.|»

‘ Select All
Deselect All
Modify
- Default

< | m

60000

Timeout [ms]:

Figure 5.7.8
DICOM Assocation Window

Film Attributes

Selecting “Set DICOM Print Film Attributes” under the “Command” menu (Figure 5.7.9) displays
the DICOM Printer Setup Dialog box. See Figure 5.7.10. In this Dialog box, the user may select
various options governing the film and print format. Selecting Default restores all of the default
options. Configurations to the settings are provided through drop down menus. To accept the
modified configuration, select OK. To reject the options and exit the window without making any

changes, select Cancel.

55 DICOM Metworking Dialeg - Bioptics Vision
SESSIOM  SECURITY VIEW COMMAND PREFEREMCES

ADD Session |
MODIFY Session |

REMOVE Session |
ASSOCIATION List |

DISCONMECT |
ECHO OM/OFF |

ECHO ON/OFF
CHECK ASS0C. FOR STORAGES

SELECT DICOM File & DICOM STORE
DICOM STORE Selected

SELECT DICOM File & DICOM PRINT
SET DICOM PRINT FILM Attributes
DICOM PRINT Selected

DICOM C-FIND Patient Root...
DICOM C-FIND Study Root...
DICOM C-FIND Patient/Study Only...
DICOM C-FIND Modality Worklist...

DICOM RETRIEVE

CANCEL Command

Figure 5.7.9
Set DICOM PRINT FILM
Attributes
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DICOM Printer Setup X

Figure 5.7.10
DICOM Printer Setup Dialog Box

Medium Type Y

Print Priority [High LJ

Number of Copies !1 L]

Film Destination lMagazine _v_]

Film Orientation |Portrait ~|

Empty Image Density [Black _:]

Border Density !Black L]

Magrification Type | REPLICATE ~]

Film Size ID [aix1 o ~|

Polarity lNormaI _V_J

Smoothing Type fMedium LI

i~ Film Density -

Max Density WL]
Min Density |D 4

-Image Display Format-

. R
@sTanoary 1« I <]

(" Slide

Default OK | Cancel

-k

PACS PRINT

The PACS Print option sends the selected image to the selected PACS DICOM printer. The
image is printed according to the film and print format options found in the Set Film Attributes
Dialog previously described. If the user initiates PACS Print from Image View, then the window
level will be chosen from the Image View. If PACS Print is initiated from the Database Dialog,
then the Window Level will be the default window level calculated by the Vision software.

Close

The Close button closes the DICOM Networking dialog box and returns the user to the area
from which the DICOM command was executed. This command also closes the connection or
association between the Vision software and the remote DICOM device if a connection was
established.
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Overview

User Annotations in the Faxitron Vision Software allows one to apply a transparent graphic
“overlay” commonly call “annotations” to an image. These annotations take the form of text,
lines, “free form” lines (Bezier curves), arrows, ellipse and boxes. This allows additional
information and “markers” to be added to the image if desired. Note that all annotations can be
easily turned on or off, in other words they can be shown or hidden at will.

Operations

To begin annotating, select the Annotations tool from the left menu. See Figures 5.4.1 and
5.8.1. By opening this dialog, the software will immediately put the user into design mode. It will
also display a “Tool Pallet.” See Figure 5.8.2 below.

Selecting Save or Cancel from this dialog will either cancel the previous annotations or Save
the current annotations to the window. It will also return you to normal imaging mode.

The tool pallet consists of fifteen (15) tool options that follow. However, the tools may be
truncated based on the needs of the user to the most common 8 tools, which are displayed in
the top row of the dialog box.

Note the behaviour of most of these tool options involve using the mouse to guide the on screen
dynamic position and shape. Mouse “clicks” are used to set the final position and shape. The
term “swipe” infers holding down the left-mouse button and moving the object around the
screen. Letting go of the left mouse or clicking the right mouse button will “set” the annotations
into a “permanent” or final position.

MNew Preset Name Here

Add as New Preset

Starting from the upper-left of the above figure a description follows of each tool options.

5.8.0
User Annotations

Figure 5.8.1
Annotation Icon

Figure 5.8.2
User Annotation Desing Tool
Pallet
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¢ Selection Tool: Use this to select (highlight) a current annotation object. Click and hold the 5.8.0 Cont.
left mouse button down, which sets a starting position, then move the mouse around.
Whatever annotations are inside the box being displayed will be selected for further use.
Release the left mouse button to finish the operation.

e Line Tool: Draw a straight line with this option. Mouse behavior same as above.

e Box Tool: Draws a box. Mouse behavior same as above.

e Ellipse (and Circle) Tool: Draws an Ellipse or circle. Mouse behavior same as above.
e Arrow Tool: Draws a line with an arrow at the end. Mouse behavior same as Line Tool.

e Polygon Open Line Tool: Draws non-straight “open segmented” lines. Left-click mouse,
hold button, draw. Release left button, this sets a line segment. Repeat as desired. Right-
click mouse button and tool operation is complete.

e Text Tool: Creates a “textbox” where you can type text-based data.
e Ruler Tool: Creates a ruled line segment. Very much like the Image Tools Ruler feature.

e Polygon Closed Line Tool: Draws non-straight “closed segmented” lines. Left-click mouse,
hold button, draw. Release left button, this sets a line segment. Repeat as desired. Right-
click mouse button and tool operation is complete.

e Curved Open Line Tool: Draws curved “open segmented” lines. (Bezier curves.) Left-click
mouse, hold button, draw. Release left button, this sets a curved-line segment. Repeat as
desired. Right-click mouse button and tool operation is complete.

e Curved Closed Line Tool: draws curved “closed segmented” lines. (Bezier curves.) Left-
click mouse, hold button, draw. Release left button, this sets a curved-line segment. Repeat
as desired. Right-click mouse button and tool operation is complete.

o Text “Balloon” Tool: creates a textbox with a line segment protruding from a corner of the
text box. This can be used to “link” text to something on your image.

e Segmented Ruler: Draws non-straight “open segmented” ruled lines. Left-click mouse, hold
button, draw. Release left button, this sets a ruled line segment. Repeat as desired. Right-
click mouse button and tool operation is complete. The length of all the ruled line segments
is shown at the end of the ruler. Useful for a rough estimate of the periphery of an object or
Patient.

¢ Protractor Tool: Draws an angle on screen and provides the degree of the angle. Just like
a protractor.

e Orthogonal Ruler Tool: Provides two (2) ruled lines that are orthogonal to each other.
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While in User Annotation Design Mode — but not in a specific operation mode — one can right-

click the mouse and get a context sensitive menu. See below.

Undo
Cut
Copy
Paste
Delete

Select All

Bring to Front
Send to Back

Hide Rotate Handles for All Objects

Default Properties »

Name...

Line...

ROP2...

Transparent

Transparent Color...

Fill...

Foreground Color...
Background Color...

Text Color...

Note Background Color...

Redact Background Color...

Hilite Background Color...
Font...

Button Font...
Hotspot Metafile...
Encrypt Metafile...
Decrypt Metafile...
Ruler...

Nodes...
Protractor...

Show Stamp Border
Point...

Encrypt...

Fixed...

Hyperlink...

Figure 5.8.3

Right-click Mouse Context
Sensitive Menu (Only During
Design Mose of User
Annotations)

Many specific settings can be made from these context sensitive menus.

Note: If an item seems too small to read or see correctly you can possibly change it from the
Right click menus shown above. Alternatively, you can choose to zoom into the image using
the Dynamic Zoom tool. This enlarges the image and you should be able to clearly see any

annotation.

Show — Hide Annotations

The Toggle Annotations button, shown in Figure 5.8.4, allows users to quickly
toggle annotations on and off. By default, the annotations will be toggled on. The

button is located in the right-side menu near the upper right corner.

Figure 5.8.4
Show/Hide Option for User
Annotations
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The “Help” submenu, See Figure 5.9.1, is located on the top menu bar and provides quick 590
access to the Faxitron Path User Manual and “About Vision”. Refer to 5.10.0 and Figure 5.10.1. About Hel p
‘ ' i Figure 5.9.1
< Dperilisers Nonial Online Help Dialog Box
About Vision
The About Vision button opens a Dialog box that shows the Vision software version and 5.10.0

copyright date and system information.

About Vision o

H

“ersion# 3.0.3.1

Yision Yersion 3.1.4.Revl U (64-Bif)
Copyright () 2005-2018 Faxitron Bioptics LLC

Frocessing Library Information
Mame: FBFrocessing.dll

—— Camera Library Information
“ersion# 1.0100 MName: BiCamTLDS dll

—— Configuration Utility Information
Yersion# 1.2.1.1

——— Camera Information

hake: Teledyne Dalsa, Serak SERIALY
hodel: xineas 2923

Sensortype: TOLS_2304x2944

———— ¥-Ray System Information
Make: BIOFTICS, Model: PATHWISION
Firrmware Wersion# PAT01.05

About Faxitron
Vision Software

Figure 5.10.1

About Faxitron Vision Information
Dialog Box
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Requirements | Faxitron Path Compliance 6.1.0
Compliance

Emission Limits .
Radiation emitted from the Faxitron Path unit does not exceed an exposure of 0.1 milli- Requ”ements and
Roentgen (mR) per hour at any point 5 centimeters (cm) outside the external surface. For Safety Measures
countries requiring emission values measured at 10 cm from the external surfaces, the

radiation does not exceed 0.1 mR per hour at 10 cm.

Safety Interlocks
Faxitron Path Specimen DR system has two safety interlocks on the specimen door.

Start Button
Following interruption of X-ray generation by the safety interlocks, the Start button on the front
panel will resume X-ray generation when ready.

Key Actuated Control

Key Lock switch located on the front panel, which requires a key to be inserted and turned
clockwise to the 3 o’clock position in order to provide power to the cabinet system. The key is
captive in the “ON” position.

Emergency Stop Button
The Emergency Stop button on the Faxitron Path front panel is available to terminate the
generation of X-rays. This is in addition to the safety interlocks on the system doors.

X-ray Generation Indicators
The Faxitron Path has an X-ray On indicator light on the front panel and graphical user
interface, and also produces an audible tone when generating x-rays.

Power Ratings
100-240 50/60 HZ 200 W MAX.

Heat Output
500 BTU/hr MAX.

LASER LOCATOR
The Faxitron Path utilizes a pair of laser generated lines to aid in positioning samples in the
middle of the imaging field.

Laser Parameters

Lasers comply with IEC 60825-1:2007
Class 2 Laser Products

Wavelength: 670nm

Peak Power: 2mW

Line Width: 1mm Typical

Beam Divergence: 85° Typical

The lasers require no assembly.

There is no authorized operator maintenance on the lasers. The lasers are to be serviced only
by a Hologic Authorized Representative.

LASER ELECTRICAL PARAMETERS

Operating Voltage: Red: 3-6VDC
Black: Ground

Operating Current: 50mA Typical
80mA MAX
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CAUTIONS: 6.1.0 Cont.

CLASS 2 LASER RADIATION WHEN THE DOOR IS OPEN. DO NOT STARE INTO THE
BEAM.

A laser beam can be damaging to the eyes, DO NOT look into the laser aperture when the
laser is in operation.

Be aware that laser light can also be dangerous when reflected off a mirror-like surface.

For further safety information regarding lasers, refer to ANSI-Z1 36.1 STANDARD FOR
THE SAFE USE OF LASERS, available from the Laser Institute of America, phone 407-380-
1553.

NOTE: The laser apertures are located in the ceiling of the X-Ray chamber.

Laser CAUTION Label: Located on upper right corner of door.

( LASER RADIATION

AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAKPOWER 2mW
WAVELENGTH 670NM

RAYONNEMENT LASER EVITEZ TOUTE
EXPOSITION DIRECTE PRODUIT LASER DE
CLASSE 2 POWER PEAK 2Mw LONGUEUR

D’'ONDE 670nmLASER RADIATION

\ IEC GOBZSy

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,
DATED JULY 26, 2001

CAUTION/ATTENTION

CLASS 2 LASER RADIATION WHEN OPEN
DO NOT STARE INTO BEAM

RAYONNEMENT LASER DE CLASSE 2 EN

CASD'OUVERTURE NE PASREGARDER
DANS LE FAISCEAU

P/N 7120-6300-J
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DICOM Version

Faxitron uses the latest DICOM standard:

ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, Final Draft,

Aug. 1993.

And complies with:

NEMA PS 3.1 - 3.20 (2016), Digital Imaging and Communications In Medicine Set

Storage Classes

FAXITRON_DR provides Standard Conformance to the following DICOM V3.0 SOP Class as

a SCU.

SCU SOP Class

SOP Class

SOP Class UID

Computed Radiography Image Storage SOP

1.2.840.10008.5.1.4.1.1.1

Digital X-ray Image Storage Presentation

1.2.840.10008.5.1.4.1.1.1.1

Digital X-ray Image Storage Processing

1.2.840.10008.5.1.4.1.1.1.1.1

Digital X-ray Mammography Image Storage
Presentation

1.2.840.10008.5.1.4.1.1.1.2

Digital X-ray Mammography Image Storage
Processing

1.2.840.10008.5.1.4.1.1.1.2.1

Study Root Query/Retrieve Info. Model -FIND

1.2.840.10008.5.1.4.1.2.2.1

Patient Root Query/Retrieve Info. Model -FIND

1.2.840.10008.5.1.4.1.2.1.1

Modality Worklist information Model-FIND

1.2.840.10008.5.1.4.31

Greyscale Softcopy Presentation Storage

1.2.840.10008.5.1.4.1.1.11.1

For further details refer to the full DICOM Conformance Statement stored on the system. The

file is in C:\Faxitron and a shortcut is provided on the desktop.

If required, a copy of the DICOM conformance statement is available from Faxitron on request.

6.2.0
DICOM Standard
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Service 7.1.0
Service and

There are no serviceable parts in Faxitron equipment. Please contact your authorized Hologic
representative for servicing.

Faxitron Bioptics LLC

3440 E. Britannia Drive, Suite 150
Tucson, AZ 85706

USA

Tel: +1 (877) 910-0030

Fax: +1 (520) 399-8182

E-mail: support@faxitron.com

Website: www.hologic.com

Troubleshooting

Computer or System will not turn on
No power to the computer or x-ray system.
Verify power to system is ON and power strip is plugged in and ON.

READY light does not stay "on”
Button was pressed BEFORE Vision Software was running or before software armed the
x-ray system for an acquisition. See Quick Start.

Image looks like there is another object in x-ray
Verify that during "Calibration” that there were no objects in the X-ray cabinet. Remove objects
and repeat Calibration.

Poor image quality

Verify that the image intensity values (I (x,y)) found in the lower Right-hand corner of the image
display window are near 10000 ADUs when preshot AEC target is also set to 10000 ADUs
and exposure mode is selected as Auto kV/Auto Time. If needed, repeat the Imaging
procedure.

Cybersecurity
If a cybersecurity event occurs disconnect the system from the network and contact Faxitron
immediately. We will work with your IT department to resolve the issue.

A cybersecurity event can be detected in a number of ways:
e Slower than normal operation and/or network connection
e  Suspicious pop-ups or home page changed in internet browser
e Password(s) no longer working
e Unidentified programs in start menu or system tray

e  Missing, corrupt or altered data

Troubleshooting
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Faxitron Path

Specimen Radiography System

SECTION
Schedule of
Maintenance

This document provides a schedule of testing and maintenance for the Faxitron Path. It is
strongly recommended that the maintenance and tests described in this section be performed
at the intervals of time indicated to ensure that your Faxitron X-Ray generator continues to

8.0.0
Maintenance

Warning: Samples containing tissue can harbor infectious agents that are
hazardous to your health. Follow appropriate biosafety procedures; wear gloves

operate at optimal performance.
when handling tissue specimens or any materials with which they come in contact.
Periodically wipe down the interior of the cabinet with 70-90% isopropy! alcohol or

diluted sodium hypochlorite (5.25%-6.15% household bleach diluted 1:500 provides the proper
concentration). Ensure the specimen area, marked on the chamber floor, is thoroughly
cleaned.

Do not use acetone or other harsh/aggressive solvents on the x-ray chamber door window.

8.1.0
Internal

Periodically wipe down the exterior surfaces with isopropyl alcohol, sodium hypochlorite, or
mild soap and water. (See 8.1.0 above for appropriate concentrations.) Do not drench or flood
surfaces and do not use abrasives which may scratch surfaces. Do not allow any moisture to
contact any of the systems electrical components. Test cleaning agents on a small
inconspicuous area of the plastic and metal covers to verify they will not damage the finish.

8.2.0
External

Except for External Cables and Fuses — the system has no user replaceable components. The
following items can be ordered and replaced by Faxitron staff or approved representatives.

¢ Digital X-Ray Detector

e PCle interface Card

e  Computer, Monitor, Mouse and Keyboard
e Controller PCB

e X-Ray Tube and HV Power Supply

e Low Voltage Power Supply

8.3.0
Replaceable Parts

¢ Acrylic Scattering Target (0.25"~ 6mm and 1” ~ 24 mm thick)

¢ ACR Phantom (Nuclear Associates P/N 18-250)

¢ lon chamber Survey Meter, Inovision Model 451B-DE-SI-RYR or similar
¢ 1 gallon (4 liter) plastic jug of water

8.4.0
Materials Needed

The following references provide information that amplifies or augments the software safety
procedures, which are defined in this document.

Safety & Cybersecurity
Any software or firmware updates that have been released since the last maintenance that
resolve a safety or security issue can be provided, as necessary.

The firmware is hard coded into the control board so if a firmware update is required, replace
the control panel PCB.

8.5.0

Reference
Documents and
Version
Information
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SECTION

Faxitron Path Schedule of

Specimen Radiography System Maintenance

The following definitions apply for the terms listed below when referenced in this Schedule of
Maintenance.

ACR Phantom- American College of Radiology Accreditation Phantom.
ADU- Analog-to-Digital Units.

AEC- Automatic Exposure Control - Computer terminates x-rays when enough signal has
reached the detector.

Contrast: Percent of difference between object intensity and background intensity.
Dark current: Thermally generated signal in the sensor; (almost) linear with time.

Flat-fielding: Gain and offset corrections performed on a pixel-by-pixel basis. Each pixel has
a different gain and offset and must be calibrated out.

Line pairs per millimeter: Number of alternating lead and air pieces. For example 10 Ip/mm
means => {air/lead} {air/lead} ... 10 times in one millimeter.

Magnification: Moving the object away from the detector and towards the x-ray source to
magnify the image of the object on the detector.

MTF: Modulation Transfer Function. A measurement of the contrast and resolution of an
imaging system.

Read noise: RMS noise measurement in 0-second dark exposure (no signal).
ROI: Region Of Interest. Generally a specific sub-region of an image.
SID: Source-to-image distance; distance from the x-ray source to the detector.

Specimen Radiography: X-ray imaging of a piece of tissue after it is extracted from
the body.

Periodic maintenance should be performed annually to ensure your Faxitron Path system
continues to perform optimally over time. This periodic maintenance includes verification of the
following:

e Safety Interlocks and Indicators, Section 8.8.0,
e ACR Phantom Test (verifies camera performance), Section 8.8.1, and

e Radiographic Survey, Section 8.8.2.

We recommend these procedures be performed annually, however government regulations
may require more frequent maintenance schedules.

8.6.0
Definitions

8.7.0
Periodic
Maintenance
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SECTION

Faxitron Path Schedule of

Specimen Radiography System Maintenance

Interlocks, Lights, Error Messages — To be performed annually

Print this page to use as reference if needed.

Record results under “Safety Interlocks and Indicators” on the Periodic Maintenance Record —
Faxitron Path, located at the end of the Section.

. System must be powered on. The key lock switch should be in the 3 o’clock position with
the key captive.

. Verify the “Power” led comes on. No other LED is illuminated at this time.

. Verify the LCD screen illuminates and displays “System Idle” and there are no other
messages, such as “Door Open” at this time.

. Open the specimen door. The LCD screen will display the message “Door Open”. When
the door is closed, this message should disappear.

. Turn the computer and monitor “ON”. Vision software should automatically start. If the
software doesn’t automatically start, double-click the Vision Software icon to start the
imaging software. If this initiates a calibration, allow the calibration to fully complete.

. Next, Click the Start Procedure button, then click the Patient Data button, and choose the
Enter Manually button to access the patient entry screen. Fill all fields marked with an
asterisk (*), and click the “Accept” button. This will allow for an exposure to be taken.

. Verify that the “Ready” LED is on. The LCD will also display a “Ready” message.

. Press the green “X-ray” button on the front of the Faxitron Path. The system should begin
taking an x-ray exposure. Make sure the LCD screen displays the bar indicator for the
exposure, as well as the exposure kV and time. Also check that the “X-Ray On” LED comes
on. You should also hear an a short beep about once per second during the exposure. Let
the exposure finish and make sure the image shows up on the computer screen.

. Press the green button again to start another exposure. While the exposure is taking place,
press the red “Stop” button and the exposure should stop within 2 seconds of pressing the
button. Most notably the buzzer will stop sounding to indicate the exposure has stopped.
The software will display interruption errors, which is expected. The errors can be cleared
which will enable x-rays to be taken.

10. Press the green button again and let the exposure start. This time, open the specimen door,
which should disengage the safety switches and force the exposure to stop. The software
may display errors, clear them.

8.8.0
Safety Interlocks
and Indicators
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SECTION

Faxitron Path Schedule of

Specimen Radiography System Maintenance

ACR Phantom (Wax Insert Only) — To be performed annually 8.8.1
ACR Phantom Test

Print this page to use as reference if needed.
Record results under “ACR Phantom Test” on the Periodic Maintenance Record — Faxitron
Path, located at the end of the Section.

The user should be familiar with using the Faxitron Path and should know the procedures of
taking X-Rays. Complete the setup procedures and make sure that the camera is calibrated,
(Note the calibration kV and time), enter the patient data, and take a picture of the wax Insert
portion of mini ACR Phantom shown in Figure 8.1. NOTE: The image will be taken with the wax
insert removed from its acrylic holder.

Figure 8.1

Typical X-ray image of wax
insert of the Mini ACR Phantom
(Nuclear Associates P/N 18-250)
The Mini ACR Phantom contains 12
objects: 4 masses, 4 fibers, and 4 groups
of  calcifications  (specks). Each
calcification group contains 6 individual
calcifications or specks. All masses,
fibers, and calcifications must be visible.

Note: The last group of calcifications may
not be visible in this picture.

ACCEPTANCE REQUIREMENTS

1. Configure the system to take a manual image of the wax insert of the Mini ACR Phantom.
Set the kV and time to those noted during the calibration.

2. Make sure that the Phantom is clean and free of debris.

3. Place the wax insert directly on the chamber floor in the middle of the image area. Do not
use attenuator blocks.

4. Start X-Rays and wait for all processing to be completed and the image to be displayed.

5. All the phantoms’ objects may not be visible when the image is first displayed. Adjust contrast
and brightness levels as needed for best image.

6. Once the image is corrected, all groups of objects should be visible.

7. Record results on the Periodic Maintenance Record.
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Faxitron Path Schedule of

Specimen Radiography System Maintenance

Radiographic Survey —to be performed at least annually or if device has been
dropped or damaged.

The following pages can be printed and used as instructions for performing the Radiogrpahic
Survey.

Record results under “Radiographic Survey” on the Periodic Maintenance Record — Faxitron
Path, located at the end of the Section.

The manufacturer recommends that a radiographic survey be performed at least annually* to
ensure radiation emissions are within the required limits. If the machine is damaged in any way
after installation, the radiographic survey should be conducted prior to putting the machine back
into use at the facility.

Required Tools
¢ Radiographic Survey Meter with Check Source (recommended ionization chamber type
survey meter like Inovision 451B, check source comes with device)

¢ 1 gallon (4 liter) plastic jug of water.

Ver|fy Survey Meter Operation
Calibration date: Verify that the survey meter calibration is current.

2. Battery Check: Check for proper battery condition. Replace batteries if required.

3. Check Operation: (If check source if available). Note: The following steps apply to the
Inovision 451B or similar lon Chamber Survey Meters. Follow manufacturers’ instructions
for other meters.

e Open the sliding Beta Shield on the bottom of the Survey Meter.

Set the meter down on the Check Source and monitor for 30 seconds.

e Survey Meter should read within tolerance listed on Calibration label.

Enter the reading on the Periodic Maintenance Record.

Close the meter’'s Beta Shield.

Important Notes
1. All radiation measurements are taken with the radiation Survey Meter no more than 2 inches
(5¢cm) from the surface of the Faxitron Path unit.

2.When recording the radiation measurements, they may need to be multiplied by 0.1 to
convert the reading from uSv/hr to mR/hr. For example, 12 uSv/hr is equal to 1.2 mR/hr.

8.8.2
Radiographic
Survey
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Faxitron Path Schedule of

Specimen Radiography System Maintenance

Radiation Survey Procedure

1

2

3
4

8

9.

. Take a background radiation reading (point meter toward the center of the room) and record
the value.

. Configure the system to take a manual image.
a. Click the Device Panel button and select Full Manual.

b. Drag the kV and Time sliders to the far right to maximize the selected kV and Time
values.

c. Click on the “SET” button.
. Verify that the “Ready” LED is on.

. Open the chamber door. Place the 1 gallon (4 liter) plastic jug of water on the chamber floor
imaging area and close the door.

.Press the “START” button and survey radiation emissions at the top, front, back, and both
sides of the cabinet. Slowly scan the entire surface with the meter. It should take 1-2 x-ray
exposures to complete each scan. Note: You will have to start x-rays multiple times to
complete the entire survey.

.Record the readings for each test location.

.If any readings are higher than the Faxitron radiation emission limit of 0.1 milli-Roentgen
(mR) per hour (1.0 pSv/h) at any point 5 centimeters (cm) outside the external surface (*),
contact a Faxitron representative to discuss repair options.

(*) 0.5 mR/h at 5 cm from external surfaces is the upper limit by US FDA CDRH for
cabinet x-ray systems. If used in another country please check with the hosting country’s
official limits for cabinet based in-vitro diagnostic radiography equipment)

For some countries, the test points should be at 10 cm from external surfaces and in
this case Faxitron radiation emission should read less than 0.1 mR/h at 10 cm from
external surfaces.

.Remove the jug of water from the x-ray chamber.

The bottom of the x-ray cabinet should be surveyed if the system is on a table, or if there are
personnel on the floor below where the system is used. Verify there is nothing in the x-ray
chamber, start an x-ray and scan the bottom of the cabinet. Record reading.

8.8.2 Cont.
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Periodic Maintenence Record - Faxitron Path
System S/N: Camera S/N:

Safety Interlocks and Indicators — per Section 8.8.0

Pass: Fail: Initials: Date:

If failed, state the reason and the actions taken to correct the failure.

Initials: Date:

ACR Phantom Test — per Section 8.8.1
Number of objects observed:  Masses: Fibers: Calcification Groups:

Pass: Fail: Initials: Date:

If failed, state the reason and the actions taken to correct the failure.

Initials: Date:

Radiographic Survey — per Section 8.8.2

Radiation Readings in: |:| mR/hr |:| uSv/hr Check Source: __ Background:
Front: Right Side: Top:

Back: Left Side: Bottom:

Pass: Fail: Initials: Date:

If failed, state the reason and the actions taken to correct the failure.

Initials: Date:

The periodic maintenance identified above was completed by:

Date Completed: Signature:
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Faxitron Path

Specimen Radiography System

SECTION

Revision
History

Version Date Description of Change

Originator

Approved by

Rev 1.0 29-June-2012 | Initial Release

Ciaran Purdy

Doug Wiegman

Rev 1.1 | 28-Jan-2016 Minor updates

Mikhail Viznyuk

Ciaran Purdy

Updated software images for metro release.
Add revision section. Re-numbered pages
into sections. Index removed.

Rev 2.0 | 24-Oct-2018

Cary McLaughlin

Ciaran Purdy

e Minor Revisions to Section 0

e Authorized EU Rep updated in Section
1

e Changes to Section 2:

- Added Warnings, Interoperable
Connections, and Cybersecurity

- Deleted “Start Up Sequence”

- Deleted “Shut Down Procedure”

- Added Radiation Safety information

e Deleted un-necessary information from
Section 3.

¢ Re-organized Section 4 for better flow
and deleted un-necessary information

e Section 5 — Re-organized numerous
sub-sections for more logical
progressions,

- Revised Start-up sequence
16-Jul-2019 - Revised Camera Calibration
section

- Changed flow of Patient Data

- Revised various sub-sections for
clarity

Added Cybersecurity information

Changes to Section 8:

- Updated Cleaning information in
8.1.0 and 8.2.0,

- Corrected references in 8.7.0,

- Updated and revised maintenance
sections, 8.8.0, 8.8.1, and 8.8.2 for
clarity.

- Deleted Maintenance Sign-Offs
from Sections 8.8.0, 8.8.1 and
8.8.2

- Created a New single page Sign
Off Sheet.

Rev 021

Alan Mihalko

S. Howerton
J. Mudd

D. Canny

D. Saraiya
R. Nash

T. Longo
M. Fremont

Rev 022 | 12-03-2019 Updated branding

Dhaval Saraiya

. Purdy

. Saraiya

. Nash

. Fremont
S. Howerton
T. Longo

SXVOO
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